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INTRODUCTION

Thank you for choosing this Icom product. This product is designed and built with lcom’ s state of the art technology
and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.

This instruction manual contains detailed instructions on how to configure your own remote control system.
Before reading this manual, read the RS-BA1 Preparations that comes with the RS-BA1 for details on how to install

the software.

IMPORTANT

READ THIS INSTRUCTION MANUAL CAREFULLY
before using the software.

SAVE THIS INSTRUCTION MANUAL. This
instruction manual contains important safety and
operating instructions for the RS-BA1.

NOTE: This instruction manual is based on Icom
Remote Utility Version 2.20 and RS-BA1 Version
2.20.
« In this manual, Microsoft® Windows® 10 Home
and Microsoft® Windows® 10 Pro are described as
“Windows 10.”
» Microsoft® Windows® 8.1 and Microsoft® Windows®
8.1 Pro are described as “Windows 8.1.”
The software cannot be used with “RT” versions of
Microsoft® Windows® 8.1.

Icom is not responsible for the destruction, damage
to, or performance of any lcom or non-lcom
equipment, if the malfunction is because of:

» Force majeure, including, but not limited to, fires,
earthquakes, storms, floods, lightning, other
natural disasters, disturbances, riots, war, or
radioactive contamination.

» The use of Icom transceivers with any equipment
that is not manufactured or approved by Icom.

PRECAUTIONS

IMPORTANT! To remotely control radios using the
RS-BA1, BE SURE that you comply with any local
regulations.

The RS-BALl is designed to remotely control
transceivers through a LAN port, wireless LAN, or
USB port (Type B/Mini-B/Micro-B).

Proper audio communication cannot be guaranteed if
you connect the Server PC to the transceiver’'s ACC
socket, MIC connector, or S/PDIF jack.

Depending on your transceiver, a few functions or
modes cannot be used, or you will need to update the
transceiver’s firmware to operate a CW keyer, using
the RS-BAL1 application.

Depending on the PC’s performance, OS, IP provider,
connection type, condition, speed, and so on, the
USB audio may be interrupted, or control by the PC
software may get delayed.

If the CPU has a heavy load, the USB audio is
easily interrupted. The settings of your audio player
application may be changed after connecting a
transceiver to the PC.

To operate your PC and peripheral devices, follow the
instructions provided in their manuals.

All copyrights associated with this manual and all
intellectual property rights associated with the
RS-BA1 application are held by Icom Inc.
Unauthorized reproduction or transmission of this
manual, or any part hereof, is prohibited.

The content of this manual, the software associated
with the RS-BA1, and the appearance of the RS-BA1
are all subject to change without notice.

Icom, Icom Inc. and the Icom logo are registered trademarks of lcom Incorporated (Japan) in Japan, the United States, the United Kingdom,
Germany, France, Spain, Russia, Australia, New Zealand, and/or other countries.
Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries.

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States, and/or other countries.
All other products or brands are registered trademarks or trademarks of their respective holders.



INTRODUCTION

FUNCTIONS AND FEATURES OF Adobe® Acrobat® Reader®

The following functions and features can be used with Adobe® Acrobat® Reader®.

» Keyword search

Click “Find” (Ctrl+F)

or “Advanced Search”

(Shift+Ctrl+F) in the Edit menu to

open the search screen.

This is convenient when

searching for a particular word or

phrase in this manual.

®The menu screen may differ,
depending on the Adobe®
Acrobat® Reader® version.

Click to open the find or search

screen or advanced search screen.

 Printing out your desired pages.
Click “Print” in the File menu, and then select the
paper size and page numbers you want to print.
®The printing setup may differ, depending on the
printer. Refer to your printer’s instruction manual

for details.

®Select “A4” size to print out the page in the

original manual size.

File BTN View Window Help
Hc

&
A
@

Select All Ctri+A

Deselect All Shift+Ctrl+A

Copy File to Clipboard

Take a Snapshot

Check Spelling »
Q Eind Ctrl+F
Advanced Search Shift+Ctrl+F
Protection 4
Accessibility »

* Find screen

Previous Next

» Advanced search screen

Search - o x

Arrange Windows

Where would you like to search?
@) In the current decument
(2 All PDF Documents in

{h My Documents v

What word or phrase would you like to search for?

[]Whele words only
[ Case-Sensitive

[ Include Bookmarks
[ Include Comments

Search

* Read Out Loud feature.

this PDF.

details.

The Read Out Loud feature reads aloud the text in

Refer to the Adobe® Acrobat® Reader® Help for the

(This feature may not be usable, depending on your

PC environment including the operating system.)

Rotate View [
G Edit View Window Help L
Page Navigation 4
B Open... Ctrl+0
Create PDF Online... Page Display J
Zoom J
Save As... Shift+Ctrl+5 Tools »
Save as Other 3
Show,/Hide [
Send File 3
Display Theme 4
Close Ctrl+W [%] Read Mode Ctri+H
Properties... Ctrl+D |:| Eull Screen Mode Ctrl+L
= Pint.. Ctrl+P EP Tracker..
L Read Out Loud }

®The screen may differ, depending on the Adobe® Acrobat® Reader® version.



INTRODUCTION

COMPATIBLE TRANSCEIVERS

The RS-BA1 is compatible with Icom transceivers that input and output audio through a LAN port, wireless LAN, or
the USB port (Type B/Mini-B/Micro-B).

Connection type Compatible transceivers

LAN port
(Transceivers with the
Server function)

IC-7851, IC-7850, IC-7800 (Firmware version 3.00 or later),
IC-7700 (Firmware version 2.00 or later), IC-7610, IC-9700

Wireless LAN IC-705

USE oort IC-7100, 1C-7200, IC-7300, IC-7410, IC-7600, IC-7610, IC-7850, IC-7851, IC-9100,
P IC-9700, I1C-705

NOTE:

« If your Icom transceiver does not have a LAN port, wireless LAN, or a USB port, you can remotely control the
transceiver with an RS-232C interface. However, RS-BA1 operation with transceivers that input or output audio
through the ACC socket, MIC connector, or S/P DIF jack cannot be guaranteed.

» Depending on your transceiver, some functions or operating modes cannot be used.

» Depending on your transceiver, a firmware update may be required to use the CW mode.

The following transceivers are compatible with the RS-BA1 Dualwatch function:
IC-7851, IC-7850 (Firmware version 1.30 or later)
IC-7610 (Firmware version 1.10 or later)
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OVERVIEW OF THE RS-BA1

» The RS-BA1 consists of the Remote Utility, used to configure a remote control system, and the Remote
Controller, used to send the CI-V commands to a Base station, to remotely operate it.
» With the RS-BA1, you can configure a remote control system through a LAN or the Internet.

About the Remote Control system
The RS-BA1 Remote Control system basically consists of the following 3 components:

(D Base station: Transceiver, or Transceiver and Server PC*
@ Network (LAN or Internet)
(3 Remote station: PC (Remote PC)

* If you use a transceiver that does not have the Server function, you have to connect a PC to the transceiver.
In the Remote Control system, you can transmit or receive the CI-V commands, control commands to turn the

transceiver ON or OFF, or communication audio through the Remote Utility.
You can remotely control the base station by the Remote PC using the Remote Controller.

A. When using the transceiver with the Server function

Other station

| iea

1
1
1
1
1
1
1
1
1
: INTERNET or | LAN
1
1
1
1
1
1
1

INTERNET or | LAN

(D Base station @ Network (3 Remote station

Other station

] ey

vi
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BEFOREUSING THEREMOTE CONTROL SYSTEM

Firewall settings

The Windows operating system includes a firewall setting standard. This is a security function that can prevent
improper access to your PC from the Internet. To let the Remote Utility work properly, add it as an exception in the

firewall.

Windows 10

1. Click the Windows icon, and then click the Setting
icon.

2. Click “Network & Internet.”

F— o x

Windar

one et & bapmet

Click
3. Click “Windows Firewall.”

Settings - o x
& Home Status
| Find a setting £ | Network status

/A Network troubleshooter
ninmmse s S network problems

w ClicK poperes

‘Windows Firewall

Network and Sharing Center

Network reset

4. Click “Allow an app through the firewall.”

Windows Defender Security Centre - o X

) Firewall & network protection
\L/\_/\_A/\_/\_/
\/\/_\/\/\/

- ternet troubleshooter

C | |Ck tion settings
105

Restore firewalls to default

» The “Allowed applications” screen is displayed.
5. Click <Change settings>.

W Allowed spphcations o X

€ T i o Windows Firewsl » Allowed applications asech Control Fane
Click
P Chege settng

Praate  Publc ~

Allew apps to communicate threugh Windeows Firewall

11

6. Click <Allow another app...>.

W Allowed spphcations o X

€ t i « Windows Firewsll » Allowed applications vl asech Cortrol Pane a

Allow apps to communicate thr incowes Firewall

Change settings.

£
i

Publ

:

L
R Allieyn Router ]
B8 Comaty Crush Soda Sage ] =2
B Cast bo Device functionaity @ @
¥ Contact Support = Ll
4 Core Networking @ E
B Delivery Cptimization L] L}
BADIAL peotacol sarve @
rdinates (n} a
] #
o (m]

* The “Add an app” screen is displayed.
Click “Remote Utility Software for Icom Radios”
and then click <Add>.

Add an app x

Select the app that you want to add or dick Browse to find one thatis not
listed and then dick QK.

Applications: o CI ICk

HREITIl)tE Utility Software for Icom Radios |

What are the risks of unblocking an app?

‘fou can choose which network types to adc g CI ICk

Metwork types... Add Cancel

« Returns to the “Allowed applications” screen.

In the “Allowed apps and features” list, confirm
that “Remote Utility Software for Icom Radios” is
displayed and a check mark is in the box, and
then click <OK>.

& Allowed applications - [m) X

<« v A @ « Windows Firewall > Allowed applications v ® | Search Contral Panel P

Allow apps to communicate through Windows Firewall
To add, change of remove allowed apps and ports, click Change settings.

What are the risks of allowing an app to communicate? & Change settings

Allowed apps and features:

Name Private  Public A
[ Remote Event Log Management [u} o
et e o a
0 C f- sent u} m]
onfirm 0 o
[m) [m]
o a
ORe o a
Search
[ Secure Sacket Tunneling Pratocol u} ]
O SNMP Trap [m] [m]
[JTPM Virtual Smart Card Manacement u] i
Details. Remove

Allow another app.

= | @ Click




1 BEFORE USING THE REMOTE CONTROL SYSTEM

Firewall settings

Windows 8.1

1. Place the mouse pointer in the bottom right corner 4. Click “System and Security.”
of the screen. 3 P . <o
« The charms are displayed on the right of the screen.

t |,

{/ —

Q=== | Click ;=

i.--‘ bl @

5. Click “Allow an app through Windows Firewall.”

,:‘ } - X Systerm and Security - EN
Charms are displayed £03 @ Mimaamemens | Click
[ O S :
" Place the mouse -

pointer around here.

g

» The “Allowed applications” screen is displayed.

i < i >
2. Click the “Settings” charm. 6. Click <Change settings>.

"4 Allowed applications = =
p (.j ~ 1 i@ « Windows Firewall » Allowed applications v e Search Control Panel P
Allow apps to communicate through Windows Firewall CI | Ck

To add, change or remove allowed apps and ports, click Change settings.
What are the risks of allowing an app te communicate? ) Change settings

Allowed apps and features:

Name Private  Public ~
[ Connect to a Network Projector a [m]
7. Click <Allow another app...>.
& Allowed applications = =
(€ = t @ « WindowsFirewall » Allowed applications v/ & | Search Contral Panel »

Allow apps to communicate through Windows Firewall

To add, change or remove allowed apps and ports, click Change settings.

What are the risks of allowing an app to communicate? & Change settings
Allowed apps and features:

Name Private  Public *

CheckPoint.VPN

. M) N kes.Ji PulseV
3. Click “Control Panel.” Dttt cone v 1

MSN Rt~

[ Connect to a Network Projector a a

Core Networking

- - [ Distributed Transaction Co-ordinator m] m]
w [Mf5wpn.client
File and Printer Sharing ]

HomeGroup [m]

[1i5CS! Service ] ]

a a

=

MIMSN 5L

Settings eait Click

Allow anothes app...

oK Cancel

PCinfo

Help * The “Add an app” screen is displayed.

» Continued on the next page.
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Firewall settings

Windows 8.1 (Continued)

8. Click “Remote Utility Software for Icom Radios”
and then click <Add>.

Add an app “

Select the app that you want to add or dick Browse to find one that is not
limbmd A Homm A‘d( 0K,

O Click
| T |

Path: C:\Program Files (x86)\lcom'RemoteUtility\Re Browse...

What are the risks of unblocking an app?
‘fou can choose which network types to add 9 CI ICk

Hetwork types . Cancel

* Returns to the “Allowed applications” screen.

9. In the “Allowed apps and features” list, confirm
that “Remote Utility Software for Icom Radios” is
displayed and a check mark is in the box, and
then click <OK>.

& Allowed applications = =

@ ~ 1 @ « Windows Firewall » Allowed applications v & Search Control Panel »p

Allow apps to communicate through Windows Firewall
To add, change or remove allowed apps and ports, click Change settings.

What are the risks of allowing an app to communicate? & Change settings

Allowed zpps and features:

Name Private  Public ~
OneNote
[IPerformance Logs and Alerts ] ]
Play To functienality
Proximity Sharing
Remote Assistance a
[0 Remote Event Log Management a a
I Remote Event Menitor [m) [m)

- lagement a [m]

© Confirm oo

i e O O
LI Remote volume management a [ -

Details... Ret

=}
el

ve

Allow anothes app...

@ Click

Sance

1-3



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the level of your audio devices

Before you start using the RS-BA1, the PC’s audio volume of your speakers or headsets must be set to a proper
level.

® Information

» When several audio devices are used, you must individually set each one.
 Configurable items, displayed screens, and terms may differ, depending on your PC.
» These instructions are based on using Windows 10.

¢,

Other station

Settings for the Remote PC

Adjust the volume level of the audio device that is connected to the PC.

« In the “Playback devices” menu, you can adjust the output level of the speaker or headset.

« In the “Recording devices” menu, you can adjust the modulation level sent to the transceiver.

(D Base station @ Network (3 Remote station

Settings for the Server PC

Adjust the audio input and output level from or to your transceiver.

« In the “Playback devices” menu, you can adjust the modulation level sent to the transceiver.
* In the “Recording devices” menu, you can adjust the audio input level from the transceiver.
® Before adjusting, connect the transceiver and your PC, and turn ON the transceiver. (p. 2-2)

1. Right-click the speaker icon on the taskbar, then 3. Select the audio device that you use, then click
click “Open Sound settings.” <Properties>.
® For the Windows 8.1, right-click the speaker icon on
the taskbar, then click “Sounds.”

% Sound X

o Cl'ck Communications

Select a playback device below to modify its settings:

Speakers
VIA HD Audio[Win 10]
0 Default Device

@ Select

@ Click

Open Volume mixer

Spatial sound (Off)

—

Configure Set Default

e © Click

Troubleshoot sound problems

* The “Sound” screen is displayed.
2. Click “Sound Control Panel.” * The “Speaker Properties” screen is displayed.

» Continued on the next page.
1-4



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the level of your audio devices

4. Confirm “Use this device (enable)” is displayed in
the Device Usage menu on the <General> tab.

@ speakers Properties x

o Cl'Ck ants  Advanced
e [Speater] |
Change lcon

Device usage: Use this device [enable] ~

@ Confirm

| [

5. Click the <Levels> tab.
Adjust the speaker’s audio level by moving the
slide control to the right or left.
After adjusting, click <OK> to close “Speaker
Properties.”
@ If the mute setting is turned ON in “Speakers”
click the icon to turn it OFF.

@ Speakers Properties *
Generz 0 Click vanced
Speakers
. LEa B Balance
@ Adjust

6. Click the <Recording> tab on the “Sound” screen.
In the list, select the audio device that you use,
and then click <Properties>.

% Sound X

Playba:w o C||Ck stions

Select a recording device below to modify its settings:

W

Microphone
VIA HD Audio[Win 10}

‘JQ Default Device

@ Select -

~ (#) muLpug

WM

LConfigure Set Default

cncd © Click

« The “Microphone Properties” screen is displayed.

7.

Confirm “Use this device (enable)” is displayed in
the Device Usage menu on the <General> tab.

| fq Microphone Properties *
t( a Click neements  Advanced
o (= |
q‘ Change lcon
@ Confirm
Device usage: Use this device (enable] ~

x| [

Click the <Listen> tab.
If a check mark is inserted in “Listen to this
device,” click to remove it.

i Microphone Properties *

Genet n Click : Advanced

You can listen to a portable music player or other device through
this Microphone jack. If you connect a microphone, you may hear
feedback,

T
® Confirm <« [3

Playback through this device:

\/W

| [

Click the <Levels> tab.

Adjust the microphone’s audio level by moving the
slide control to the right or left.

@ If the mute setting is turned ON in “Microphone”

, click the icon to turn OFF.

';‘ Microphone Properties e

General Lisil c Click snced

Microphone
; . 82 [qn
® Adjust
Microphone Boost
. 0.0 dB

| [

» Continued on the next page.



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the level of your audio devices

10. When connecting the transceiver to the PC with
a the USB cable, and when using the RS-BA1
Dualwatch function, click the <Advanced> tab

and then confirm the “Default Format” is set to 2
channel.

:‘ Microphone Properties *

General Listen Levels o C||Ck

Default Format
Select the sample r

. used when running
in shared mode. e Conflrm

2 channel, 16 bit, 43000 Hz [DVD Quality) Y

Exclusive Mode

Allow applications to take exclusive control of this device

Give exclusive mode applications priority

Restore Defaults

Cancel Apply

11. After adjusting, click <OK> to close “Microphone
Properties.”

1-6



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Transceiver’s presettings

The RS-BA1 remotely controls the transceivers using CI-V (lcom Communication Interface-V) commands.
See the CI-V command table in the transceiver’s instruction manual for details of the functions that can be
controlled.

The following manual settings are required when operating the RS-BA1

Properly preset the items in the table below for functions that cannot be controlled by CI-V commands, or for items
that may cause unintended actions. See the transceiver’s instruction manual for details of the settings or operation.

NOTE:

» Remove the transverter from the transceiver, if it is connected.

 To prevent an accidental transmission, we recommend you remove any key, keypad, or other external devices
connected to the transceiver.

» Set the transceiver to a normal operating mode. The transceiver cannot receive CI-V commands in special
modes, such as the firmware update mode, clone mode, terminal mode, or access point mode.

» If the transceiver has the Time-Out Timer function, we recommend that you turn ON the function to prevent the
transceiver from continuously transmitting.

Genre Items Model Contents

RIT function Transceivers without the Server function | Set to OFF.
(Except for the IC-7100, IC-7300, IC-7600)

ATX function Transceivers without the Server function | Set to OFF.
(Except for the IC-7300, IC-7600)

Simple band scope IC-746PRO*1, IC-7000*1, IC-7100, |Setto OFF.

Function IC-7400*1, IC-7410, 1C-9100,

SWR Measuring IC-746PRO*1, IC-7000*1, IC-7100, Set to OFF.

function IC-7400*, IC-7410, IC-9100

Weather Alert function [IC-7100, IC-705 Set to OFF.

Timer/Sleep Timer Transceivers with the Timer function |Set to OFF.

function

RTTY decode screen

IC-746PRO*!, IC-756PROIII*1,

Close the screen.

Display IC-7400"1
Volume for the RX All Set to a suitable level.
Volume .
audio
CIl-V Baud Rate All (Except for the IC-705) 19200 bps (or “Auto”).
CI-V Address All Desired CI-V Address
@ If other devices are connected to the system,
BE SURE to not set a duplicate address.
Cl-V CI-V USB Port IC-7300*2, IC-7610*2, IC-9700*?, Set to “Unlink from [REMOTE].”
IC-7850 (Firmware version 1.10 or later)*?,
IC-7851 (Firmware version 1.10 or later)*?
CI-V USB Baud Rate IC-7300*2, IC-7610*2, IC-9700*?, Set to “115200” (or “Auto”).
IC-7850 (Firmware version 1.10 or later)*?,
IC-7851 (Firmware version 1.10 or later)*?
USB Serial Function Transceivers with a USB (Type B) port | Set to “CI-V” for the selected
connection method.
Set mode

RS-232C Function

Transceivers with an RS-232C port

Set to “CI-V” for the selected
connection method.

*1 Operations cannot be guaranteed.
*2 \When connecting to the USB port and using the Scope function.

NOTE: When using the IC-PW1, BE SURE to set CI-V Baud Rate to “19200 bps.” After changing the transceiver’s CI-V
settings, be sure to reset the CPU of the IC-PW1 and set the transceiver’s CI-V settings on the IC-PW1. See the IC-PW1
instruction manual for details.
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Transceiver’s presettings

The following settings are automatically set in the transceiver

When the Remote Controller connects to the transceiver, and you select the model name on the Connect Setting
screen, the following items are automatically set. If you manually operate the transceiver, set these items.

Genre Items Model Contents
MAIN/SUB Tranking IC-7610, Automatically set to OFF.
function IC-7850 (Firmware version 1.10 or later),

IC-7851 (Firmware version 1.10 or later)
SSB/CW Synchronous | All Automatically set to OFF.
Tuning
Calibration Marker Transceivers with the Calibration Automatically set to OFF.
Function Marker function
VOX function All Automatically set to OFF.
Scan function All Automatically cancels the scan.
RTTY filter IC-746PRO*1, IC-756PROIII*, Automatically set to OFF.
IC-7400*!
Twin Peak Filter IC-746PRO*1, IC-756PROIII*2, Automatically set to OFF.
IC-7400*!
Dualwatch function*2 IC-7600, IC-7800, IC-756PROI||I*1 Automatically set to OFF.

Display SUB band 1C-9100, IC-9700 Automatically set to OFF.
Memory channel/ All Automatically set to the VFO mode.
Call channel

. DR (D-STAR Repeater) |1C-7100, IC-9100, IC-9700, IC-705 |Automatically set to OFF.
Operating mode
Mode | Satellite mode IC-9100, IC-9700 Automatically set to OFF.
Type of |DD (Digital Data) mode |IC-9700 Automatically set to the FM mode.
emission
CI-V transceive All Automatically set to ON.
Cl-v CI-V 731 Mode IC-746PRO*!, IC-756PROIII*, Automatically set to OFF.

IC-7400*!

*1 Operations cannot be guaranteed.
*2 The Dualwatch function is automatically set to OFF when using the Single mode screen
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Selecting a connection method

There are 3 connection methods. Select one from the following.

When you want to configure the system using a cable, see Section 2.

)

When you want to configure the system using a LAN, see Section 3.
® When using a transceiver with the Server function, you do not need a Sever PC.

- N

RS-BA1

Transceiver
on the 2nd floor

Remote PC

\  onthe 1st roor<

RS-BA1

@Remote station

Base station

GERERED
EERERED
DORERED
EORERED

Transceiver
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B ” CONFIGURING THE SYSTEM THROUGH A CABLE

Examples of the remote control system

This section explains the minimum required settings to operate the transceiver through a cable, using the
following illustration as an example.

You can also refer to each application’s Help file for assistance with the functions and settings. While the
application is open, push the [F1] key on the PC’s keyboard to open the Help file.

RC-28
(Purchase separately)

Cable

Transceiver Remote PC

Name: 1C-7300
CI-V address. 94h
Baudrate: 19200

TIP: If you use an RC-28 REMOTE ENCODER
connected to the Remote PC, you can use the
RS-BA1 and feel like you are operating the actual
transceiver’s MAIN dial.
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 1. Select a connection method

Check the connector type on your transceiver and see the following chart to connect your transceiver to the PC.
To connect an Icom CI-V command capable transceiver to the PC, you have to make connections for control

command and audio communication.
® The RS-BA1 operation with the PC connected to the transceiver’s ACC socket, MIC connector, or S/P DIF jack for audio
communication cannot be guaranteed.

Transceiver’s Outline Model Ref
connector Control command Audio '
Through a USB cable IC-7100, IC-7200, IC-7300, |p.2-3

_ _ *1

[USB] port IC-7410, IC-7600%*1,

IC-7610, IC-7850, IC-7851,
IC-9100, IC-9700, IC-705
Through the CT-17 cI-v Through an audio cable All (Except for the IC-705) |p. 2-4
LEVEL CONVERTER connected between the
[REMOTE] jack PC’s audio terminal and the
transceiver’s [ACC] socket
or [MIC] connector

Through an RS-232C Through an audio cable IC-7700%2, IC-7800%*2 p. 2-5
cable connected between the

[RS-232C] PC’s audio terminal and the

connector transceiver’s [ACC] socket,

[MIC] connector, or
[S/P DIF] jack

*1 To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver's [REMOTE] jack.

*2 To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver's [REMOTE] jack or
directly connect to a LAN.

NOTE: About the USB connection
The USB driver shown below is required to use the RS-BA1.

Model Transceiver’s USB port type Install the driver in the:

IC-7100 Mini-B

IC-7200, IC-7300, IC-

7410, 1C-7600, IC-7610, | Type B “Driver” > “CP210x” folder*

IC-7850, IC-7851, IC-

9100, IC-9700

IC-705 Micro-B “Driver” > “lcom USB Serial Port Driver” folder

*When a PC with USB 3.0 port is used to operate the transceiver, confirm the driver name. If the name “Silicon
Laboratories CP210x USB to UART Bridge (Driver Removal)” is displayed on the Control Panel screen, uninstall
it and then install the latest driver.

& Home Apps & features

Find a setting talling apps

Uninseall
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2

CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [USB] port:

NOTE: For IC-7600 users
To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’'s [REMOTE] jack.

(p. 2-4)

1

System requirements

« APC that has a USB 1.1, 2.0, or 3.0 port

« Icom CI-V command capable transceiver that
has a [USB] port (Type B/Mini-B/Micro-B)

* The USB cable

Install a USB driver.

CAUTION: DO NOT connect the transceiver to
the PC with the USB cable until the USB driver
installation has been completed.

The driver is not supported by the Windows®
automatic recognition system.

To use the USB cable between the transceiver
and the PC, you must first install a USB driver.
The USB driver comes with the RS-BA1. You can
also download it from the lcom website.

The latest driver and installation guide can be
downloaded from here:
https://www.icomjapan.com/support/firmware_driver/
Read the installation guide before installing the
driver.

2-3

3

Connect the transceiver to the PC.

Connect the transceiver to the PC using the USB
cable.

This guide is based on using a Type B USB
cable.

USB cable

To [USB]

Server PC

NOTE:

« If you connect a new USB audio device to
your PC, the device selected as the default on
your PC may be changed.

* DO NOT connect another transceiver using a
USB cable while the Remote Ultility is open.



2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [REMOTE] jack:

Connecting an audio cables
Connect an audio cable between the PC’s audio
ports and the transceiver’s [ACC] socket or

1 System requirements 3
« APC that has an RS-232C connector
« Icom CI-V command capable transceiver that

has a [REMOTE] jack

* The optional CT-17 CI-V LEVEL CONVERTER
® Mini-plug cables are included

* An RS-232C cable (Supplied with the CT-17)

 Stereo audio cables (User supplied)

2 Connect a remote control system.
Connect the CT-17 to the PC, which enables the
Cl-V communication between them.

Icom transceivers

=5 0s0

O bio
50
(e]
C_Juuuuu
Ol
(9
0
O
OO

mini-plug cable
(Supplied with the CT-17)
[ e ————

O

RS-232C cable

CT17

To [RS-232C]

(Supplied with the CT-17) N

To [RS-232C]

S

9~15VvVDC

Server PC

NOTE: The CT-17 accepts only an RS-232C
cable. The use of an RS-232C-USB converter

is not guaranteed.

2-4

[MIC] connector to enable audio communication

between them.

@ See the transceiver’s instruction manual for details

on the connector.

Transceiver
AF (Output) = LINE
MOD (Input) €« LIN

e Connect to [ACC]
(Rear panel view)

Example: IC-7600 (8 pin)

MOD ———
,r GND
}—‘ AF —===———— |

e Connect to [MIC]

Example: IC-7600 (8 pin)
(Front panel view)

1

1

1

1

1

1

1

1

©0 !

3828 :
B oo :_

1

1

1

1

1

1

1

1

+ 1
MIC input —H—'

m |
<£ @~ — GND 10pF/16V 1
@ ® :
9 @) !

AF output = — ——— 1

Example: IC-7000
(Rear panel view)

[T
@

®MICE

+
®MIC input —EH

PC
IN/MIC IN (Input)
E OUT (Output)

Connect to
LINE IN

or

MIC IN

GND

&
Not used
AF

=

- >

-

Server PC

-

Connect to
LINE OUT

GND

P
Not used
MOD

10pF/16V

CAUTION:

» When using the [MIC] connector, DO NOT
directly connect an audio cable between the
transceiver’s Microphone input and PC. It

can cause a malfunction with

out adding the

Electrolytic capacitor, as illustrated above.
» DO NOT connect a monaural plug to the PC’s
LINE OUT. It can cause a malfunction.



2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to a transceiver’s [RS-232C] connector:

NOTE: For IC-7800 or IC-7700 users

To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’s [REMOTE] jack or
directly connect to a LAN.

1 System requirements 2 Connect a remote control system.
* A PC that has an RS-232C connector Connect an RS-232C cable between the
« Icom CI-V command capable transceiver that transceiver and the PC.
has an [RS-232C] connector
« An RS-232C cable (User supplied)
« Two S/P DIF digital cables or stereo audio
cables (User supplied)

To [RS-232C]

RS-232C cable
(User supplied)

To [RS-232C]

Server PC
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [RS-232C] port (Continued):

3 Connecting an audio cables

Connect an audio cable between the PC’s audio port and the transceiver’s [S/PDIF] jack, [ACC] socket, or
[MIC] connector to enable audio communication between them.
® See the transceiver’s instruction manual for details on the transceiver’s connector.

Using the [S/P DIF] jack
Transceiver
S/PDIF OUT >
(Output)
S/PDIF IN (Input)

PC
S/PDIF IN (Input)

€ S/PDIF OUT (Output)

Optical cables

(User supplied) 9

— = 1+

Server PC

2-6

Using other than the [S/PDIF] jack
Transceiver PC
AF (Output) = LINE IN/MIC IN (Input)
MOD (Input) € LINE OUT (Output)

Connect to
LINE IN

or

MIC IN

e Connect to [ACC]
(Rear panel view)

GND
MOD

&
Not used
AF
GND

@@ !
l
| e
e Connect to [MIC] :
l
|

(Front panel view) ’ \ Server PC

MIC input —+H—,
éﬂ GND  10pF/16V i Connect to
©®Q®) : LINE OUTGND
AF output -————-—
Not used
MOD

CAUTION:

» When using the [MIC] connector, DO NOT
directly connect an audio cable between the
transceiver’s Microphone input and PC. It can
cause a malfunction without adding the Electrolytic
capacitor, as illustrated above.

* DO NOT connect a monaural plug to the PC’s LINE
OUT. It can cause a malfunction.



2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

This section describes how to setup the PC.
® Before configuring the settings, turn ON the transceiver.

1 Open the Remote Utility.
1. Open “lcom Remote Utility.”
2. “Set your own PC information.” is displayed, setyouroun P nfermatin.
then click <OK>.

Remote Utility X

® When you first open the Remote Utility, this L JC“Ck
screen is displayed.
Configure the settings.
2 ® When you first open the Remote Utility, this screen setiings rox \
is displayed. @ Enter
1. Enter a name for your PC of up to 16 congolport uor)  [5001 \
characters. (Example: Server PC) SendzortQop) | [0007 @ Confirm
® DO NOT use the same name for more than one audoportuor) | [0003 \
PC on your network. tetworc Conrectn [ wved =] ® Select
2. Confirm the port numbers of the Control, it Acssne @ Select
Serial and Audio ports. Lnage ® Select
@® Normally, use the default port numbers for ®) Click
these ports.
3. Select the network connection type. Vv
4. Select your Internet access line type. e =
5. Select the software display language.
® The selected language will be used as the Help The changes wil be effctafer the applcaion resars
file language. ——
6. Click <Register> to save the settings. —
7. Click <OK>, and then restart the Remote @ Click
Utility.
3 Click the Setup that you want to do. Setup Wizerd I
® If no servers or no radios are registered, this screen Clck the Setup that you want to do.
is displayed.
Click “Setup for a Local PC (Directly connect the 8 _@ L, _@
radio and PC).”
(8 rad Vet Sane ) Coman g 3 S 20
@ Click
|D..em>f ?;vpn':ﬁriath:o:c‘imp Carvd PC) (The radio ?sa;cpc'ezr;h\?;eéznfme PCis))
4 Start the Setup Wizard. sewpatosl e T
Click <Next>>. et the Setup Wizerd

Setup alocal PC

Register a Radiathat is directly connected ta the FC.

To cortinue, click <Next>

- [E=T] ciiek
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

5 Select a transceiver. Register o Radio roox
1. Select a transceiver that you want to add. e s ot ot

(Example: USB)

[ the radio is connected to the PC using a USB cable, select the radio from the [USB] drop-down list. Then click

® If the transceiver is ot listed, dlick <Search>. e S R T R
@® Select “Manual” if the transceiver is connected the radic is connected to the PC using other than a USE cable, sslect fram the radic from the [Manual]

drop-down list. Then click <Nesd>

to the PC using other than a USB cable.
Select the connected transceiver from the drop-
down list. Cremat [ M Select E

2. Click <Next>>.
o] @ ok

6 Set the CI-V/COM port settings. Regiter s Radio rox
1. Set the CI-V address, Baud rate, and COM et e r0e o s
PO rt N um be r. If you wart to change the CI-V address and/or Baud rate, change from the lists below.
“ » The Radio has the Spectrum scope function, f you use the function on the Remote Corttroller, the USB Baud
® If you select “USB” in step 5, there are no R e e
[REMOTE]".
necessary changes.
2. Click <Next>>.

Search

& [sg 1C-7300 comM=3 -

The COM port number is automatically set. ff they are no necessary changes, dick <Next>

Address |94
Baud Rate |115200 - @
Set

COM Port Number  [COM3
=[] @ click

TIP: When you select “Manual” in step 5

Register a Radio 7 x
The Audio Settings screen is displayed. :“‘éi;’.f‘hi'il"d?:a.mm
Select the devices that input a received audio from
the transceiver and output a modulation signal to the Ry ey CEh = mestvd sud fom et an ot modaten e rade
transceiver, and then click <Next>>. e e -1: D Select
[ Moo ouputpeviee [hotuses Bk @ Select

Device Options
Search

¥ Displays Detected Radio's Device

I Displays Virtual Device

_[Te] @ ciie

7 Enter the radio name. Register o oo rox
1. Enter the radio name. P et e e 720
® The model name and the last 5 digits of the S
serial number are entered by default. e
2. ClICk <NeXt>>. Click <Nest> to register to the Radio.
Redone[1c 7o0mmm _| | @ Enter

e[ e | @ Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

8 The registration of the Radio is complete. Regiter  Radio :
Click <Finish>. Add Completed

The registration o the Radio is completed. To connectto the Radio, using the Radio List screen

Attention:

By connecting the Radio to & LISE port, the defauit settings on the REC/PLAY device window may change to
the Radio’s Speaker and Microphone:

Inthat case. no sound comes from the original speaker, or you cannot input audio from the micraphone. To
corfim the settings, dlick the <Sound Setfings > button below

Or, i you use Dualwatch, make sure that the Microphone of the UISB audio is set to 2 channels on the
Windows “Sound Settings” screen. f it is set to 1 channel, the receive audio forthe Sub band cannot be
output

Sound Settings

/N

R4 A

<54 Click
1

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio’s Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

% Sound x

Playback flacording Sounds  Communications

Select a playback device below to modify its settings:

Speakers
VIA HD Audio[Win 10)
o Default Device

% Sound x

Flaybac| Recording Sofinds  Communications

Select a recording device below to modify its settinas:

’T Microphone
VIA HD Audio(Win 10)

‘?o Default Device
| a Line In
VA LR A
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

9 Connect the transceiver. B Icom Remote Utiity - x
. File SetupWizard Options Help
1. Click <Connect>. Radott | e ]|

« The dialog that notifies the virtual serial port is (7300 BENED
displayed.
@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-2)
2. Click <OK>.
« “<<Connected>>" is displayed under the radio
name when the connection has succeeded.

Settings || Comnect @ C“Ck J MoD | Monitor | Delete:

Remote Utility X

Serial port number is (3},

@ Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 4. Starting the Remote control operation

This section describes how to connect and remotely control a transceiver from a PC using the Remote
Controller.
The description in this section is based on the assumption that:
* The transceiver is turned ON.
* The connection to the transceiver using the Remote Utility has succeeded.
(“<<Connected>>" is displayed under the radio name.)

1 Connect setting using the Remote Controller application
1. Open “RS-BA1 Remote Control Ver2.”
2. Click< > in the toolbar, or click “Connect Setting...” in the Option menu.
» The Connect Setting screen is displayed.
® You cannot change the settings while the transceiver is connected to the Remote Controller.
3. Select a transceiver to access using the Remote Utility application, in Model.
(Example: 1IC-7300 (Ver1.20 -))
4. Select the connection between the transceiver and PC in Connection.
(Example: USB)
® If the “MOD Select has also been changed.” dialog may be displayed. Click <OK>.
® The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected
correctly, click <OK>.
5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
(Example: 1IC-7300 XXXXX)
 The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the
virtual COM Port number, transceiver’s Cl-V address, and baud rate.
@ If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information
from the Remote Utility application.
6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote
Controller application is closed by clicking < > or “Exit” on the File menu.
® When the PC shuts down while the Remote Controller application is still running, the transceiver’s power may not
turn OFF.
® For other settings, see the Remote Controller’s Help file.
7. Click <OK> to save the settings and close the screen.

® Select
@ Select

107300 - @ Se|ect
Search
ci
COM Port Baud ratefbps]

3 hd 19200 A

CIV addiess CIY address
(Racio) (RSEA1)

94 E0 -

See the Audio Device [Yoice Memory]
Help file ICOM_VALDIO A (icom Vinualiud =

I~ IEPWA iz cornectzd,
[ Controlled by older commands:.
-

@ C| |Ck @,onwaue closing tuns OFF the Radio,
@ Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 4. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < [[8] > in the toolbar, or click “Connect ON” in the File menu.
* When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the

following settings, depending on the transceiver’s connector.

1. Click <MIC SET> on the Remote Controller.
» The MIC SET screen is displayed.

2. Select a connector in MOD Select (Remote ON) (Example: USB), to input transmit audio from the PC to
the transceiver.

3. Click the close button to close the screen.

wicser [ @ ciiek

MOD Select
[Remate OM]

@ Select

MOD LEVEL

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function.
® To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the [F1] key on
your PC’s keyboard.

NOTE:
» DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not
work properly after the PC resumes normal activity.
* When not using the transceiver:
Follow the steps below to finish the remote control operation.
1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller
application.
2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
3. Turn OFF the transceiver and the PC.
® If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also
turned OFF.
» When you manually select the transmit audio input connectors to be used after finishing the remote control
operation, right-click [ in the toolbar, or click “Remote Setting...” in the File menu to select.
® Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.
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3

CONFIGURING THE SYSTEM THROUGH A LAN

Examples of the remote control system

This section explains the minimum required settings to configure a remote control system through a LAN,

using the following illustrations as examples.

® Only the Remote PC users whose ID and password are registered to the Base station transceiver or the Server
PC can connect to it. BE CAREFUL in managing IDs and passwords.

® You can also refer to each application’s Help file for assistance with the functions and settings. While the
application is open, push the [F1] key on the PC’s keyboard to open the Help file.

A. When using a transceiver with the Server function (p. 3-2)

B

Base station transceiver
(Connet to wireless LAN)

e

INTERNET

I

RC-28
(Purchase

Router

Connect to [LAN]

Base station transceiver

Name: IC-7851abc
CI-V address: 8Eh

Baud rate: 19200

IP address:  192.168.0.10

B. When using the Server PC (p. 3-4)

IP address: 192.168.0.1

INTERNET

Server PC

Name: Server PC
IP address: 192.168.0.10
Computer name: ServerPC

Transceiver

® The user ID, password, and other settings in these
illustrations are only examples. Configure the
system using your own settings.

separately)

|

Remote PC
Name: User PC
User ID: USER1

Password: USER0001

RC-28
(Purchase

Router
IP address: 192.168.0.1

3-1

separtely)

|

Remote PC
Name: User PC
User ID: USER1

Password: USER0001

TIP: If you use an RC-28 REMOTE ENCODER
connected to the Remote PC, you can use the
RS-BA1 and feel like you are using the actual
transceiver’'s MAIN dial.




3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function

Set each setting item on the Base station transceiver.
® If you want to connect to the Internet and remotely control the transceiver, see Section 4.

NOTE: When you change a setting that displays “(Valid after Restart),” you must restart the transceiver after
setting. After restarting, keep the transceiver’s power ON or remain in the remote standby mode.

Network setting Transceiver registration
Items Contents Items Contents
DHCP* ON (Default) A Network Radio Name
Network Radio Name | ® Up to 16 characters
Network Name* A Network Name Example: IC-7851abc

Example: IC-7851

Network Control OFF (Default) — ON

Control Port (UDP) | 50001 (Default)

. Transmit audio setting
Serial Port (UDP) 50002 (Default) (For the IC-7800 and IC-7700)

Audio Port (UDP) 50003 (Default) e SarETE
I/%Lg Internet access line Network MOD Use | ON (Default)
Internet Access Line | Example: FTTH (Fiber To
The Home)
(Default)

* |f you set DHCP to “OFF” to use the IP address
instead of the network name, or you use an I1C-7800
or IC-7700, set the items shown below.

Items Contents

An IP address that is not

assigned to any other device.

Example: 192.168.0.10
(Default)

IP Address

An IP address of the LAN
Default Gateway | side on the router
Example: 192.168.0.1
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3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function (Continued)

User registration

Items Contents

A User ID
® Up to 16 characters
Example: USER1

Network User1/2/3*
ID

A Password

® 8 ~ 16 characters

® At least 2 different
characters must be used.

Example: USER0001

Network User1/2/3*
Password

NO (Default) —» YES
® When the user is set as an
administrator.

Network User1/2/3*
Administrator

* There is no User3 in the IC-7610, IC-9700, and IC-705.

NOTE: To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers
or characters.

TIP: Standby mode setting

To remotely control the transceiver using the RS-BA1, the transceiver should be turned ON or be in the standby
mode.

To set the transceiver in the standby mode, set the item described below and select

“Standby (for Remote Control)” on the displayed screen when you turn OFF the transceiver.

® The [POWER] LED slowly blinks orange if the transceiver is in the standby mode.

Items Contents

Shutdown Function
(Except for the IC-7610)

Power OFF Setting (for Remote Standby/Shutdown

Control)
(For the 1C-7610)

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 3-10)
Confirm the transceiver settings described below.

» Network Name or |IP Address

* Network User ID and Password

® Keep the transceiver’s power ON, or remain in the Remote Standby mode
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3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC

Connect the transceiver to the Server PC and setup the Remote Utility.
® If you want to connect to the Internet and remotely control the transceiver, see Section 4.

1 Connect the transceiver to the Server PC.
Connect the transceiver to the Server PC with a
cable.
® See page 2-2 about the connection.

2 Open the Remote Utility.
1. Open “Icom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Utility, this
screen is displayed.

3 Configure the settings.
® When you first open the Remote Utility, this screen
is displayed.
1. Enter a name for your PC of up to 16
characters. (Example: Server PC)
@® DO NOT use the same name for more than
one PC on your network.
2. Confirm the port numbers of the Control,
Serial and Audio ports.
® You should use the default port numbers for
these ports.
Select the network connection type.
Select your internet access line type.
Select the software display language.
® The selected language will be used as the Help
file language.
6. Click <Register> to save the settings.
7. Click <OK>, and then restart the Remote Utility.

ks w

Click the Setup that you want to do.

® If no Servers and no transceivers are registered,
this screen is displayed.

Click “Setup for a Server PC (The radio is

accessible by Remote PC(s)).”

5 Start the Setup Wizard.
Click <Next>>.

3-4

Remote Utility x

Set your own PC information

Click

Settings % ‘

@ Enter

PC Name

Control Port (UDF) | 50001 ‘

Serial Port (UDP) 50002 @ c .
onfirm

Audic Port (UDP) EX |

Network Connecton [ [wirea =~ @ Select

E— @ Select

® select

® Click

v

Remote Utility X

The changes will be effect after the application restarts.

@ Click

Setup Wizard ? X

Click the Setup that you want to do.

Setup for a Remote PC
(A radio with the Server function)

=

Setupfora Local PC
(Directly connect the radio and FC)

Setup for 2 Remote PC
{Connect through a Server FC)

e -

Setupfor a Server FC
(The radio is accessible by Remote PC(s))

Click

Setup a Server PC ? x

Start the Setup Wizard

Setup a Server PC.

Register  Radiathet is directly connected to the PC to use remote operation from other PCs.

To cortinue, click <Next>

_Click




3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

6 Select a Radio for the Remote operation. Regiser e Racio T x
1. Select a transceiver that you want to add. s st s et
@ If the transcelver has already been regIStered, Select new]if you want to register a new radio that is accessble from other PCs
select “Registered radios” and select it from the Or selec from [Regitered racios].

After selecting. click <Next>

drop-down list.
2. Click <Next>>.

& Few!

¢ Registered rados [Select = radio |

[T 1] click

7 Selecting a Radio Register a Fadio PR~

Selecting a Radio

® If you select “Registered radios” in step 6, go to the Seloc » Radio tht youswerd to
next page (step 9).

If the radio is connected to the PC using a USB cable, select the radio from the [USB] drop-down list. Then click

1. Select a connection type (Example: USB). e e e B e TR
@ If the transceivers are not listed, click <Search>. e s comnecisd s he P using e @ USE cale, st o e rs fom e fanual
“ ” . . rop-down list. Then click <Next>.

® Select “Manual” if the transceiver is connected

to the PC using other than a USB cable. Pl ey ons ] | s |

H " Manual ither
dSelectI the connected transceiver from the drop- " @ select -
own list.

2. Click <Next>>. @ck @ Click

8 Set the CI-V/COM port settings. Register Radio roox

CI-V/COM port Settings

@ If you select “Registered radios” in step 6, go to the <ol the I 730010 D g

next page (step 9).
If you wartt to change the CI-V address and./or Baud rate, change from the lists below.
1. Setthe CI-V address, Baud Rate, and COM [;:Wa o et i
Port Number.
® If you select “USB” in step 5, there are no
necessary changes. Addess oa

. < >> Baud Rate | 115200 -
2. Click <Next>>. e | @ Set

The COM part rumber s automaticaly set. f they are no necessary changss, dlick <Next>.

@ Click
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3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

When you select “Manual” in step 7:

Register a Radio ? x
The Audio Settings screen is displayed. :Udiuse“m
Select the devices that input a received audio from ot the sude ol the o
the transceiver and output a modulation to the Solct e devn ot it e oo e st oot e
transceiver, and then click <Next>>. — g
[ oo cuputDevie " [nat uzes =1l @ Select
 semwch | Device Options

v Displays Detected Radio’s Device

™ Displays Virtual Device

=] o clek

9 Register a User to allow a connection. Fegiters o _ roox
1. Click <Add>. e Lo s shon v o G700
» The Add User screen is displayed.
2. Enter a User ID_ (Example: USER1) E:r?‘:‘rznaggfﬁr;:jlz;\:t;?nnmm If no user s registered, click <Add> to register the Add User screen. You
3. Enter a password of more than 8 characters. Regetered e scceatle ser
(Example: USERO0001) b
4. Click <OK>, ek |
5. Select a registered user. @ Click
6. Click <Add >>>.
7. Click <Next >>. stk | Mot Cancl
v

[Add User x|
®Enter [t Tosea |

prew——— 4

® Enter | Fin €
Cancel

(Example: ——  —

USER0001) @) Click To set the user as
an administrator,
click to put a
check mark.

v

Register s Radio ? X
Register a User to allow a connection
Register a User to allow a connection 1o 1G-7300.
Heg\ﬂer al Userlo EHOW a Donned\or\ If no user s registered. click <Add> to register the Add User screen. You
@ Click speuer
USERL (Admin) USERL (Admin
Add>>
((DE|EtE
Add
w[Lee 1] @ click

NOTE: To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers
or characters.



3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

10 Enter the radio name. Regr s 7 %
1. Enter the radio name. e ——
® The radio’s model name and the last 5 digits of o
the serial number is entered by default. This rame s dipleyed o the Rodio s scroen
2. CI|Ck <NeXt>>. Click <Nexd > to register to the Radio

Redoame [C7000 = | @ Enter

@ Click

11 The registration of the Radio is completed.
Click <Finish>. Regiter s Rao .

Add Completed

The registration of the Radiois completed. To connect to the Radio, using the Radio List soreen

Attention:

By connecting the Radiato a USB port, the defaut settings on the REC/PLAY device window may change to
the Radio’s Speaker and Microphone.

Inthat case. no sound comes from the original speaker, or you cannot input aucio from the micraphone. To
confim the seftings, cick the <Sound Setfings> button below.

Or, if you use Dualwatch, make sure that the Microphone of the USB audio is set to 2 channels on the

Windows "Sound Settings” screen. If it is set ta 1 channel. the receive audio for the Sub band cannot be
output

Sound Settings

N

=27 | Click

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio’s Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

‘ % Sound X

Playback fl=cording Sounds Communications

Select a playback device below to modify its settings:

Speakers
VIA HD Audio(Win 10)
Default Device

% Sound X

Playbac| Recording Sglinds Communications

Select a recording device below to modify its settings:

" Microphone
VIA HD Audio(Win 10)

““@ Default Device

| ,a Line In
VIA HD Avidinafdfin 1M

NOTE: Before “Step 2. Settings on the Remote PC’s Remote Utility application”
Confirm the Server PC settings described below.

e PC name or IP Address

* User ID and Password registered to the Remote Utility

® Keep the transceiver’s power ON and open the Remote Utility.
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3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

TIP: Server PC name and IP address

Server PC’s computer name or IP address.

Remote stations. Find out your PC’s computer name.

1. Click the folder icon on the taskbar.

= B

2. Right-click “This PC,” and then click “Properties.”

| 4 [ = ThisPC
Computer View
< « 4 B ThisPC
s Quick access ~ Folders (6)
@ Right-click esctop =g
=
Expand
¥ Network e F
& Manage | =i
4 Homegroup Pin to Start

Map network drive..,
Open in new window
Pin to Quick access b

Disconnect network drive...
Add a network location

D~tesn

r @ Click

If you configure the remote control system through a LAN, Remote stations can access the server using the

A computer name is used on networks to identify a particular workstation on the network.
The example below describes how to find out the Server PC’s computer name or IP address to be requested by

3. The “System” screen is displayed. Confirm the
name that is displayed in Computer name.

o | System

Control Panel Home

& Device Manager

G Remote settings

G System protection

&) Advanced system settings

4+ E4 5 Control Panel > All Control Panel ltems » Systemn

View basic information about your comp

Windows edition
Windows 10 Home
© 2015 Microsoft Corporation. All rights reserved,

System
Processor: Intel(R) Core(Th) i7 ¢
Installed memory (RAM):  2.00 GE
System type: 64-bit Operating Syst
Pen and Touch: Ne Pen or Touch Inp

Computer name, demain and workgroup settings

Confirm |

Cormputer name: Server PC

Full computer name: Server PC

Cormputer description:
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3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

TIP: Server PC name and IP address (continued)

An IP address is a humerical label that is assigned to devices patrticipating in a computer network.
Find out your PC’s IP address.

1. Right-click the Network icon on the taskbar, and 4. The Ethernet Status screen is displayed, and
then click “Open Network & Internet settings.” then click <Details...>.
W' Ethernet Status x
General
Connection
IPv4 Connectivity: Internet
IPv6 Connectivity: Mo network access
Media State: Enabled
Duration: 00:40:16
Speed: 1.0 Gbps
Click
Activr
® When using Windows 8.1, click “Open Network and v -
Sharing Center” and go to step 3. sent .-'-',:r, Received
2. Click “Network and Sharing Center.” Bytes: 160,355,161 i 2,573,483,568
GEmpemes Gglsabls Diagnose
& Home Status
| Find a setting £ Network status Close
\_/\_/\M
) 5. The Network Connection Details screen is
Network and Sharing Center . . .
Click displayed, and then confirm the IP address that is
displayed in the Address field.

Click <Close> to close the window.
3. The Network and Sharing Center screen is

displayed, and then click “Ethernet.”

Network Connection Details x

Metwork Connection Details:

L Property Value “
4 A 4 ConbrolPanal + Metworkand Intermet + Mitwork and Shiring Center Connection-specific DN
View your basic network information and set up connections @ Confi m
Vi yoour actave rotwarks nrienreoti
Hetwark s e i | IPv4 Address 192.168.0.10
Prrvate setaon i —_ —t - L o
ch.m e [
Lease Obtained u

Change your networking Sestings

= Setup & beosdtund, dist

- Lease Expires
Click IPv4 Defaul Gateway

IPv4 DHCP Server
IPv4 DNS Servers

o VPN dormection: of 36t up & reuter o BEcess point

orget samation.

IPv4 WINS Servers

NetBIOS over Tepip En..
Link-ocal IPv6 Address

< >

@ Click |

w

TIP: When DHCP Enabled is set to “Yes” in the
Network Connection Details screen, the DHCP
server assigns a dynamic IP address to your
PC. Therefore, Remote stations have to match
the IP address each time to access the Server
PC.

If DHCP Enabled is set to “Yes,” we
recommend that you let Remote stations
access the Server PC using its computer name.
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3

STEP 2. Settings on the Remote PC’s Remote Utility application

CONFIGURING THE SYSTEM THROUGH A LAN

This section describes how to setup the Remote PC.
® Before configuring the settings, connect a speaker and microphone or headset to the PC.

1

2

Open the Remote Utility.
1. Open “Icom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>,
® When you first open the Remote Utility, this
screen is displayed.

Configure the settings.
® When you first open the Remote Utility, this screen
is displayed.

1. Enter a name for your PC of up to 16
characters. (Example: User PC)
® DO NOT use the same name for more than one

PC on your network.

2. Confirm the port numbers of the Control,

Serial and Audio ports.

Remote Utility x

Set your own PC information

Click

Settings

7 x ‘
© Enter

Control Port (UDF) | 50001 ‘

Serial Port (UDP) 50002 @ C .
onfirm

Audio Port (UDP) 50003 |

@ Select

S @) Select

® Select

® Click

® You should use the default port numbers for
these ports.

3. Select the network connection type. v
4. Select your Internet access line type. Remte Uiy x
5. Select the software display language.
® The selected language will be used as the Help e et

file language. o]
6. Click <Register> to save the settings.
7. Click <OK>, and then restart the Remote Utility. @ Click

3 Click the Setup that you want to do. Setup Wizerd I
® If no servers nor no radios are registered, this Clck the Setup that you want to do.
screen is displayed.

Click “Setup for a Remote PC (A radio with the _ _@ L _@
Server function)” or “Setup for a Remote PC Click
(Connect through a Server PC)." puSsmmaTere pospame e

® Example: “Setup for a Remote PC (A radio with the

Server function)” @ &‘_ N

Setupfora Local PC Setupfora Server PC
{Directly connect the radio and PC) (The radio is acosssible by Remote PCs))

4 Start the Setup Wizard. Sup o et F—
CI|Ck <NeXt>>_ Start the Setup Wizard

Setup for a Remote PC.

Register a Radio with the Server function that is connected to a LAN

To continue. click <Next:
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3

STEP 2. Settings on the Remote PC’s Remote Utility application

v

CONFIGURING THE SYSTEM THROUGH A LAN

Enter the Server Information.
1. Enter the transceiver Network Name or IP
Address.
® When using a Server PC, enter the Server PC’s
computer name or IP address. (p. 3-8)
2. Confirm the Control Port number.
® You should use the default port number for this
port.
3. Click <Next>>.

Enter the User ID and Password.

1. Enter the User ID and Password that are
registered to the transceiver.

2. Click <Next>>.
« After clicking <Next>>, connects to the server.

Adding the Server has been completed.
1. Enter the Server Description.
® The Server Address or Network Name is
entered by default.
2. Click <Finish>.

3-11

Add a Server ? X
Server Information

Enter the Server Address or Network Name and Conbol port,

Enter the Server Address or Network Nams. and then click <Next>
ff the Control port of the Server is changed, enter the number.

Server Address or Network Name
1C-7851

| @ Enter
| @ confirm

e[| e || ® Click

Control Port (UDF]

50001

Add a Server ? x

User ID and Password
Enter the User D and Password to use to access the Server,

Enterthe User ID and Password that are registered to the Server.
Click <Nest>to connect to the Server.

User ID

USER1

Password [T @ Enter

(Example: USER0001)

[T @ ek

TIP: If you cannot connect to the server, an error
dialog is displayed.
Click <<Back>, and confirm the settings.

Add a Server ? X

The Server Connection failed

The Server is not found. Cannot connect to the Server.
Click <Back> and confirm the Server address or Network name

Or click <Next> to save the Server.

Cancel

Add a Server ?

Add completed

Addingthe Server has completed.
Erter the Server description. Click <Finish,  there is nothing to change

@ Enter

Server Description

fic-7851]

The following radios that are registered to the Server are added to the Fadio List
To connect to the radio, using the Radio List screen,
-IC-7851abe

_ [l ] @crick




3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 2. Settings on the Remote PC’s Remote Utility application

Configure the settings to connect to the ?e‘m;::"x::“*;m v - x
transceiver. e
1. Select the transceiver. (C78512bo

2. Click <Settings>.

3. Click <Recommended>.

» The Select Network screen is displayed. o e

4, Sglect LAN. @ Click

5. Click <Next>.

» The recommended values for your network are
displayed.
6. Click <Yes> to automatically set the
displayed values in each field of the Network
Setting, then close the Select Network
screen. —| .
7. Select a virtual COM port number. |—LI @Click v o] oo
® The selected COM port number is used for v
CI-V operation with the transceiver.

® When you connect to the transceiver with the P I— T
Remote Controller, you have to set the COM TN R S
port number. e [ <] [aex =]

8. Select an audio device in Speaker that your Cocecs [ipcr 20n e ] [rpom b El
speaker is connected, to output the received R li=———0 Sl
audio from the network. ¥ e oo ® Click

9. Select an audio device in Mic that your
microphone is connected, to transmit the V
input audio to the network. Fv— —

10. Click <OK>.

Choose the connection method to a server.
e et e s @ Select
 Internet
Connected through the Internet,
Or connected via VPN, Choose this.
[ ® ciick

v

Remote Utility

Updates the connection information in the following contents, OK?

AF Transmission : Enabled
Sample Rates : 16kHz
Codecs : LPCM 2¢ch 16bit
Prebuffer: 80

MOD Transmission : Enabled
Sample Rates : 8kHz
Codecs : LPCM 1ch 168bit
Prebuffer: 100

Retransmission Audio Data : Enabled

IC-7851abc (IC-7851) ? x
~Network Setting
[V AF Transmission [¥ MOD Transmission
Sample Rates [16kr1z =] [se =]
Codecs [LPcm 2¢h 1ebit =] Jepcm eh 1ebit -]
Prebuffer (ms) Ji 80 — |— 100
[¥ Retransmission Audio Data Recommended
" @ Select
el comport b | I - | g
Speaker |Default Device [ Cl Se|eCt
Mic |Defauit Device EEl =
virtual Audio Sample Rates (change effective after the application restarts.) |4a @ Se I eCt
|
oK H
l|- @ Click
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3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 2. Settings on the Remote PC’s Remote Ultility application

Connect the transceiver. B com Remare Uity - %
. File SetupWizard Options Help
1. Click <Connect>. _ _ _ Radott | e ]|
. T_he dialog that indicates the virtual serial port is e
displayed.

@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-2)
2. Click <OK>,
« “<<Connected>>" is displayed under the radio
name when the connection has succeeded.

Settings || Comnect @ C“Ck J MoD | Monitor | Delete:

Remote Utility x

Virtual serial port number is (2)

@ Click
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3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 3. Starting the Remote control operation

This section describes how to connect and start remotely controlling a transceiver from a Remote PC
using the Remote Controller.

The description in this section is based on the assumption that the connection to the transceiver using the Remote
Utility has succeeded. (“<<Connected>>" is displayed under the radio name.)

Connect setting using the Remote Controller application
1. Open “RS-BA1 Remote Control Version 2.”
2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
» The Connect Setting screen is displayed.
® You cannot change the settings while the transceiver is connected to the Remote Controller.
3. Select a transceiver to access using the Remote Utility application, in Model.
(Example: IC-7851 (Ver1.30 - ) (DUAL))
4. Select the connection between the transceiver and PC in Connection. (Example: LAN)
® When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
® The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected
correctly, click <OK>.
5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
(Example: IC-7851abc)
» The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the
virtual COM Port number, transceiver’s CI-V address, and baud rate.
® If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information
from the Remote Utility application.
6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote
Controller application is closed by clicking < > or “Exit” on the File menu.
® When you shut down the PC while the Remote Controller application is still running, the transceiver may not be
turned OFF.
® For other settings, see the Remote Controller’s Help file.
7. Click <OK> to save the settings and close the screen.

Connect Setting X

® Select

@ Select
Remate Lty

[cmee -] (5 Select
Cl

COM Port Baud rate{bps]
2 hd 19200 hd

CIV addiess CI¥ address
(Radio) (RS-BA1]

udio Device [Voice Memon!
ee the
Help file ICOM_VALDIO 2 (lcom Witual iud

[ ICFW is connected,
[ r

| Setradio's access to TX side.
@ Click @;onwa.e clasing tums OFF the Radi.
@ Click
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3 CONFIGURING THE SYSTEM THROUGH A LAN

STEP 3. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < [[8] > in the toolbar, or click “Connect ON” in the File menu.
* When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the

following settings, depending on the transceiver’s connector.

1. Click <MIC SET> on the Remote Controller.
» The MIC SET screen is displayed.

2. Select an appropriate connector in MOD Select (Remote ON) (Example: LAN), to input transmit audio
from the PC to the transceiver.

3. Click the close button to close the screen.

® ek

MOD Select
[Remaote OM]

LN

MOD LEVEL

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function.
To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the
[F1] key on your PC’s keyboard.

@ Select

NOTE:
« DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not
work properly after the PC resumes normal activity.
* When not using the transceiver:
Follow the steps below to finish the remote control operation.
1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller
application.
2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
3. Turn OFF the transceiver and the PC.
@ If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also
turned OFF.
» When you manually select the transmit audio input connectors to be used after finishing the remote control
operation, right-click | in the toolbar, or click “Remote Setting...” in the File menu to select.
® Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.
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B 4  CONFIGURING THE SYSTEMTHROUGH THE INTERNET

Examples of the remote control system through the Internet

This section explains the minimum required settings to configure a remote control system through the
Internet, using the following illustrations as examples.

® Only the Remote PC users whose ID and password are registered to the Base station transceiver or the Server
PC can connect to it. BE CAREFUL in managing IDs and passwords.

® You can also refer to each application’s help file for assistance with the functions and settings. While the
application is open, push the [F1] key on the PC’s keyboard to open the help file.

A. When using the transceiver with the Server function (p. 4-5)

e

Router

Router

RC-28
(Purchase
Connect to [LAN] separtely)

|

Base station transceiver
(Connet to wireless LAN)

Base station transceiver
Name: IC-7851abc

Cl-V address. 8Eh
Baud rate: 19200

Remote PC

Name: User PC
User ID: USER1
Password: USER0001

B. When using the Server PC (p. 4-7)

NN

Router Router RC-28
(Purchase
separately)
Transceiver Server PC Remote PC
Name: Server PC Name: User PC
IP address: 192.168.0.10 User ID: USER1
Domain name: ServerPC Password: USER0001

® The user ID, password, and other settings in these
illustrations are only examples. Configure the
system using your own settings.

TIP: If you use an RC-28 REMOTE ENCODER
connected to the Remote PC, you can use the
RS-BA1 and feel like you are using the actual
transceiver’'s MAIN dial.
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

About a public IP address and the Dynamic DNS service

If you configure the remote control system through the Internet, PCs can connect to the transceiver using its public
IP address or domain name.

< To let PCs connect to the Base station using its public IP address

A public IP address is an address that is accessible over the global Internet. Check the router’s manual about how
to configure your router to set the public IP address.

NOTE:

« If you have a dynamic public IP address, we recommend that you use the Dynamic DNS service to enable the
PCs to connect to the transceiver.

« If the PC connected to the transceiver is not using the Dynamic DNS service, you need to change setting of
PC’s Remote Utility to connect to the transceiver each time its public IP address changes.

(R

INTERNET

g

IP address
WAN: sk skesksk skskesk ksl

LAN: 192.168.0.1 Router Router

A
Server PC
Base station transceiver
(Transceiver with Remote PC
the Server function)
Request “sksksk sk skokok skoksk”
) (Public IP address)
Transceiver
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

About a public IP address and the Dynamic DNS service

< To let PCs connect to the Base station using its domain name

If you set up an account for a Dynamic DNS server, the DNS server resolves the domain name into your dynamic
IP address. Using the domain name, PCs can connect to the Base station through the Internet, even if the Base
station’s public IP address is changed.

® Check the router’s manual about how to configure your router to use the Dynamic DNS services.

Dynamic DNS

server N

Update with your

INTERNET
dynamic IP address
IP address /
WAN: skeskesk skeskesk skeskesk skesksk
LAN: 192.168.0.1
Domain name: Router Router
icom-rsbal.com
A
Server PC

Base station transceiver
(Transceiver with
the Server function)

Remote PC

Request “icom-rshal.com”
(Domain name)

Transceiver
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

Port forwarding

If you configure the remote control system through the Internet, you need to configure your router to enable

connections from the Internet.
To enable connections, forward the port used with the Remote Utility.

NOTE: Icom is not responsible for any accidents caused by the security degradation after this port forwarding.

INTERNET

Forwarded port numbers
50001 ~ 50003

Forwarded port numbers

50001 ~ 50003 Router Router

A B Server PC
Static IP Address:
192.168.0.100

Base station transceiver
(Transceiver with
the Server function)

Static IP Address:
192.168.0.100

Remote PC
Static IP Address: 192.168.0.100

Transceiver
Default Gateway: 192.168.0.1

. . . DNS Server address: 192.168.0.1
Example: The transceiver directly Example: The transceiver connected to the

connected to the network network through a PC

Default Gateway: 192.168.0.1

1 Set the static local IP address to the Base station or Server PC.
Set a static local IP address to the Base station or Server PC.

® Information
« Usable IP addresses differ, depending on your router. Check the router’s manual for details.

* DO NOT set the same IP address to 2 or more devices that are connected to the same router.
* Check your PC’s manual about the setting details.

Transceiver setting

Items Contents
DHCP ON (Default) — OFF
An IP address that is not assigned to any other device.
IP Address Example: 192.168.0.10 (Defa?JIt) ’
Default Gateway An IP address of the LAN side on the router
Example: 192.168.0.1
Control Port (UDP) 50001 (Default)
Serial Port (UDP) 50002 (Default)
Audio Port (UDP) 50003 (Default)

2 Forward the port.
» Forward port numbers that are used for the RS-BA1. (Default: 50001 ~ 50003)

« “UDP” should be used as the port protocol.
» Set a static local IP address in step 1 as a destination port.

® Check the router’s manual about how to forward ports.
® Depending on the router settings, you must configure the IP filter settings. Check the router’s manual how to configure

the settings.
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function
Set each setting item on the Base station transceiver.

NOTE: When you change a setting that displays “(Valid after Restart),” you must restart the transceiver after
setting. After restarting, keep the transceiver’s power ON or remain in the remote standby mode.

Network setting User registration
Items Contents ltems Contents
Network Control OFF (Default) — ON Network User1/2/3* A User ID
] ® Up to 16 characters
Your Internet access line ID Example: USER1
type
Internet Access Line | Example: FTTH (Fiber To A Password
The Home) + | © 8~ 16 characters
(Default) l;:;vg:vrcl)(rgserUZB ® At least 2 different

characters must be used.
Example: USER0001

NO (Default) —» YES
® When the user is set as an
administrator.

Network User1/2/3*
Administrator

* There is no User3 in the IC-7610, 1C-9700, or IC-
705.

NOTE: To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers
or characters.
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function (Continued)

Transceiver registration

Items Contents

A Network Radio Name
Network Radio Name | ® Up to 16 characters
Example: IC-7851abc

Transmit audio setting
(For the IC-7800 and IC-7700)

Items Contents

Network MOD Use ON (Default)

TIP: Standby mode setting

To remotely control the transceiver using the RS-BAL, the transceiver should be turned ON or be in the standby
mode.

To set the transceiver in the standby mode, set the item described below and select

“Standby (for Remote Control)” on the displayed screen when you turn OFF the transceiver.

® The LED above [POWER] slowly blinks orange if the transceiver is in the standby mode.

Items Contents

Power OFF Setting (for Remote

Control) Standby/Shutdown

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 4-11)
Confirm the settings described below.

* Public IP adress or Domain name (p. 4-2)

* Base station’s Network User ID and Password

® Keep the transceiver’s power ON, or remain in the Remote Standby mode
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4

CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< B. When using the Server PC
Connect the transceiver to the Server PC and setup the Remote Utility.

1

5

Connect the transceiver to the Server PC.
Connect the transceiver to the Server PC with a

cable.
® See page 2-2 about the connection.

Open the Remote Utility.
1. Open “Icom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Utility, this
screen is displayed.

Configure the settings.
® When you first open the Remote Ultility, this screen
is displayed.
1. Enter a name for your PC of up to 16
characters. (Example: Server PC)
® DO NOT use the same name for more than
one PC on your network.
2. Confirm the port numbers of the Control,
Serial and Audio ports.
® You should use the default port numbers for
these ports.
Select the network connection type.
Select your internet access line type.
5. Select the software display language.
® The selected language will be used as the Help
file language.
6. Click <Register> to save the settings.
7. Click <OK>, and then restart the Remote Utility.

P w

Click the Setup that you want to do.

® If no Servers and no radios are registered, this
screen is displayed.

Click “Setup for a Server PC (The radio is

accessible by Remote PC(s)).”

Start the Setup Wizard.
Click <Next>>.

4-7

Remote Utility

Set your own PC information.

Settings

7 X ‘
@O Enter

PC Name:

Control Port (UDP)  ['50001

Serial Port (UDF) 50002 @ C .
onfirm

Audio Port (UDP) 50003 |

e [ 7] @ Select

s @ Select

® Select

® Click

v

Remote Utility x

The changes will be effect after the application restars.

@ Click

Setup Wizard ? X

Click the Setup that you want to do.

-

Setup for s Remote FC
(A radio with the Server function)

=

Setup for a Remote PC
{Connect through a Server PC)

- -

Setup for a Local FC Setup for a Server PC
(Dinectly connect the radio and PC) (The radio is accessible by Remote PC(s))
Setup a Server PC ? x

Start the Setup Wizard

Setup a Server PC.

Register a Radio that is dirsctly connected to the PC to use remote operation from other PCs.

To cortinue. click <Next:

| =21 | click




4

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

Select a Radio for the Remote operation.
1. Select a transceiver that you want to add.

@ If the transceiver has already been registered,
select “Registered radios” and select it from the
drop-down list.

2. Click <Next>>.

6

Selecting a Radio
® If you select “Registered radios” in step 6, go to the
next page (step 9).
1. Select a connection type (Example: USB).
@ If the transceivers are not listed, click <Search>.
® Select “Manual” if the transceiver is connected
to the PC using other than a USB cable.
Select the connected transceiver from the drop-
down list.
2. Click <Next>>.

v

Set the CI-V/COM port settings.
® If you select “Registered radios” in step 6, go to the
next page (step 9).

1. Set the CI-V address, Baud Rate, and COM
Port Number.
@ If you select “USB” in step 5, there are no

necessary changes.
2. Click <Next>>.

8
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CONFIGURING THE SYSTEM THROUGH THE INTERNET

Register a Radio ? b

Select a Radio for Remote operation
Select a Radio that i accessible from other PCs,

Select [new] f you want to register a new radio that is accessble from other FCs
Or select from [Registered radios].

After selecting. click <Next>

@ fiw
¢ Registered rados [Select = radio |
= Jﬂl CI ICk
E———
Register & Radio ? X

Selecting a Radio
Select a Radio that you wart to add

[ the radio is connected to the PC using a USB cable, select the radio from the [USB] drop-down list. Then click
<Next>. I the radio is not listed. confirm the radio is ON and the cable is fimly connected. Watt for a while until
the PC recognizes the device, and then click the <Search> button

[ the radio is connected to the PC using otherthan a USE cable, select from the radio from the [Manual]
drop-down list. Then click <Ned:>

Search

© [

T B @) select

= oo

1C-7300 COM=3 A

Register a Radio ? x

CI-V/COM port Settings
Set the IC-7300's C14 settings.

¥ you wart to changs the CHV address and/or Baud rate, change from the lits belaw.
The Radio has the Spectrum scope function. f you use the function on the Remote Controllr, the USB Baud
rate must be set to 115200 bps. At this time, also corfirm the setting of the CI-V USB Port item is "Unlink to
[REMOTET".

The COM port rumber s automaticaly sat. I they are no necessary changes, dlick <Next>

Address |94
Baud Rate |115200 hd
COM Part Number |COM3

@ Set

_w[ &1 | @ Click




4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

When you select “Manual” in step 7:

Register a Radio ? X
The Audio Settings screen is displayed. ju.ﬁ.]gemngs
Select the devices that input a received audio from s
the transceiver and output a modulation to the e o ecsvd s e k3 3 ot ok
transceiver, and then click <Next>>. [Freee e 0 Select
[ Moo Gutput pevee ot usee -]« @ Select

¥ Displays Detected Radio’s Device

I™" Displays Virtual Device

=] @ ciek

Register a User to allow a connection. Regiser 2 Radio rox
1. Click <Add>. e a1 s et 7301
* The Add User screen Is dlsplayed Register a User to allow a connection. if no user is registered, click <Add> to register the Add User screen. You
2. Enter a User ID. (Example: USER1) e
3. Enter a password of more than 8 characters. Regetered e scceatle ser
(Example: USER0001) id>>
4. Click <OK>. <o |
5. Select a registered user. @ Click
6. Click <Add >>>,
7. Click <Next >>. <o | mets Cancel
A 4
[add User x|

Q@ Enter [me =
_asswnrd [Freme==s % adnin €€
@ Enter = S
I Cancel
(Examp|e: 7-

USERO0001) @ Click To set the user as
an administrator,
click to put a
check mark.

v

Register s Radio ? X

Register a User to allow a connection
Register a User to allow a connection to 1C-7300.

Register a Userto allow a connection. f no useris registered, click <Add> to registerthe Add User screen. You

® Click ® ClicK wsewe

USERL (Admin) USERL (Admin
i Add>> ]
<<Delete

=L 1] @ click

NOTE: To prevent unauthorized access
Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers
or characters.
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

10 Enter the radio name. Reginersfado roox
1. Enter the radio name. e e ot o G700
® The radio’s model name and the last 5 digits of e
the serial number is entered by default. This name is disiayed on the Rado is soeen.

Click <Next> to register to the Radio

2. Click <Next>>.
rdorene iz~ (T) Enter

11 The registration of the Radio is completed.
Click <Finish>. Register a Radio 2

Add Completed

The registration of the Radiois completed. To connect to the Radio, using the Radio List soreen

Attention:

By connecting the Radiato a USB port, the defaut settings on the REC/PLAY device window may change to
the Radio’s Speaker and Microphone.

Inthat case. no sound comes from the original speaker, or you cannot input aucio from the micraphone. To
confim the seftings, cick the <Sound Setfings> button below.

Or, if you use Dualwatch, make sure that the Microphone of the USB audio is set to 2 channels on the

Windows "Sound Settings” screen. If it is set ta 1 channel. the receive audio for the Sub band cannot be
output

Sound Settings

N

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio’s Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

‘ % Sound X

Playback fl=cording Sounds Communications

Select a playback device below to modify its settings:

Speakers
VIA HD Audio(Win 10)
Default Device

% Sound X

Playbac| Recording Sglinds Communications

Select a recording device below to modify its settings:

" Microphone
VIA HD Audio(Win 10)

““@ Default Device

| ,a Line In
VIA HO AnAiandfin 1M

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 4-11)
Confirm the settings described below.

¢ Public IP adress or Domain hame

« Base station’s Network User ID and Password

® Keep the transceiver’s power ON, or remain in the Remote Standby mode
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

This section describes how to setup the Remote PC.
® Before configuring the settings, connect a speaker and microphone or headset to the PC.

1 Open the Remote Utility. Remte Uity x
1. Open “Icom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Utility, this
screen is displayed.

Set your own PC information.

Click

2 Configure the settings. sesings R
® When you first open the Remote Utility, this screen - @ Enter
is displayed. controlPort (D7) [ 50001 ‘

1. Enter a name for your PC of up to 16 serarortor) | [002 -
characters. (Example: User PC) nudoportop) | [H00T ®\ Confirm
® DO NOT use the same name for more than Neswar Comecton [ wired =] ® Select

one PC on your network. Intzet Acces Line @ Select

2. Confirm the port numbers of the Control, Lerguege (®) Select
Serial and Audio ports. ®) Click

® You should use the default port numbers for

these ports. A 4

3. Select the network connection type. S .
4. Select your Internet access line type.
5. Select the software display language. Thechanges wil be ffect afcr the spplicaion restars

® The selected language will be used as the Help —

file language. ==
6. Click <Register> to save the settings. @ Click
7. Click <OK>, and then restart the Remote Utility.
3 Click the Setup that you want to do. Setup Wizard rox
® If no servers nor no radios are registered, this Clck the Setup that you wan to do.
screen is displayed.

Click “Setup for a Remote PC (A radio with the » L _@
Server function)” or “Setup for a Remote PC <=8 | Click
(Connect through a Server PC).” poStm o

® Example: “Setup for a Remote PC (A radio with the

Server function)” a @ —

Setupfora Local PC Setupfora Server PC
is accessible

{Directly connect the radio and PC} (The radio by Remote PC{s) )
4 Start the Setup Wizard. Setup for 2 Remote PC 7 X
Click <Next>>. Start the Setup Wizard

Setup for a Remote PC

Register a Radio with the Server function that is connected to a LAN

To continue, click <Next>.

Click
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

Enter the Server Information. Add o Server rox
1. Enter the Base station’s domain name or et s s et e nd Cortlpot

public IP Address.
2. Confirm the Control Port number.
® You should use the default port number for this
port.
3. Click <Next>>.

Enter the Server Address or Network Nams. and then click <Next>
ff the Control port of the Server is changed, enter the number.

Server Address or Network Name
[ | D Enter

Control Port (UDF]

oo | @ confirm

e[| e || ® Click

Enter the User ID and Password. Adda Server 7 x
1. Enter the User ID and Password that are

registered to the transceiver.
2. Click <Next>>. O ot et e S ottt Sever

« After clicking <Next>>, connects to the server.

User ID USER1

Password [T @ Enter

(Example: USER0001)

=] @ ciex

TIP: If you cannot connect to the server, an error
dialog is displayed.
Click <<Back>, and confirm the settings.

Add a Server ? X

The Server Connection failed

The Server is not found. Cannot connect to the Server,
Click <Back> and confimm the Server address or Network name

Or click <Next> to save the Server.

Cancel

7 Adding the Server has been completed. Add 2 Servr ?
1. Enter the Server Description. Add completed
® The Server Address or Network Name is
entered by default. Eﬁfe‘??h'!%ﬁ!‘?é!::’nﬁﬁé”n"‘%ﬁ <Finish>. f there is nothing to change

2. Click <Finish>. e
[ @ Enter

The following radios that are registered to the Server are added to the Fadio List
To connect to the radio, using the Radio List screen,
-IC-7851abe

_ [ ] ®@click
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

8 Configure the settings to connect to the Base ?e‘m;::"x::“*;m v - x
station. e
1. Select the transceiver. (C78512bo
2. Click <Settings>.
3. Click <Recommended>.
» The Select Network screen is displayed. o e
4. Select Internet. :
5. Click <Next>. @ Click
» The recommended values for your network are
displayed.
6. Click <Yes> to automatically set the
displayed values in each field of the Network
Setting, then close the Select Network
screen. —I .
7. Select a virtual COM port number. |—LI @Click v o] oo
® The selected COM port number is used for v
CI-V operation with the transceiver.
® When you connect to the transceiver with the IC-7831abe icom-rsbal.com) X
Remote controller, you have to set the COM R ¥ MO Transmission
port number. sonplefates[160% o =l
8. Select an audio device in Speaker that your e e Al
speaker is connected, to output the received R @ Click

audio from the network.
9. Select an audio device in Mic that your A 4
microphone is connected, to transmit the

. . Select Network ? X
input audio to the network.
10. Click <OK>. Choose the connection method to a server.
© LAN

Directly connected or throuch a network hub.

et

Connected thraugh the Intemet. @ Select

Or connectad via VPN, Choase this, ‘

-‘ ® Click
4

Remote Ltility

Updates the connection information in the following contents, OK?

AF Transmission : Enabled
Sample Rates : 16kHz
Codecs : LPCM 2¢ch 16bit
Prebuffer: 120

MOD Transmission : Enabled
Sample Rates : 8kHz
Codecs : LPCM 1ch 16bit
Prebuffer: 150

Retransmission Audio Data : Enabled

|| ® Click

1C-7851abc (icom-rshal.com) 7 x
Network Setting

[V AF Transmission [¥ MOD Transmission
Sample Rates [16krz | = -]
Codecs [ 2ch 18bit =] [pcM 1ch 166it =]
Prebuffer (ms) - = =
[V Retransmission Audio Data Raocm—mendadl
~Device £ @ Select
| el o ort b [T DR | 8

| Speaker |Default Device

Lefle

= (8 Select
| Vi |Default Device a4 B

‘ virtuzl Audio Sample Rates (change effective after the application restarts.) |¥ @ Se I eCt

[ ® click
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

B Icom Remate Utility

Connect the transceiver.
1. Click <Connect>. Hdmiwul)p -
* The dialog that indicates the virtual serial port is (G785 12bc
displayed.

@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-2)
2. Click <OK>,
« “<<Connected>>" is displayed under the radio
name when the connection has succeeded.

s | comnect @ Click J oo | wonter | Delete

v

Remote Utility x

Virtual serial port number is (2)

@ Click
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 3. Starting the Remote control operation

This section describes how to connect and start remotely controlling a transceiver from a Remote PC
using the Remote Controller.

The description in this section is based on the assumption that the connection to the transceiver using the Remote
Utility has succeeded. (“<<Connected>>" is displayed under the radio name.)

Connect setting using the Remote Controller application
1. Open “RS-BA1 Remote Control Version 2.”
2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
» The Connect Setting screen is displayed.
® You cannot change the settings while the transceiver is connected to the Remote Controller.
3. Select a transceiver to access using the Remote Utility application, in Model.
(Example: IC-7851 (Ver1.30 - ) (DUAL))
4. Select the connection between the transceiver and PC in Connection. (Example: LAN)
® When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
® The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected
correctly, click <OK>.
5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
(Example: IC-7851abc)
» The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the
virtual COM Port number, transceiver’s CI-V address, and baud rate.
® If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information
from the Remote Utility application.
6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote
Controller application is closed by clicking < > or “Exit” on the File menu.
® When you shut down the PC while the Remote Controller application is still running, the transceiver may not be
turned OFF.
® For other settings, see the Remote Controller’s Help file.
7. Click <OK> to save the settings and close the screen.

Connect Setting x

i 3 Select
Connection
L | @ Select

Femote Utility

[cmee ] (5 Select
Cl

COM Port Baud rate{bps]
2 hd 19200 hd

CIV address CIV address
(Radic) (R5-BA1)

See the “Audio Deviee [Voice Memory)
He|p file I1COM_VAUDIO-2 [lcom Yirtual Aud -

[T ICFW1 is connected,
[ -

| Setradio's access to TX side.
@ Click @iofkware clasing tums OFF the Radio.
@ Click
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4 CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 3. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < [[8] > in the toolbar, or click “Connect ON” in the File menu.
* When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the

following settings, depending on the transceiver’s connector.

1. Click <MIC SET> on the Remote Controller.
» The MIC SET screen is displayed.

2. Select an appropriate connector in MOD Select (Remote ON) (Example: LAN), to input transmit audio
from the PC to the transceiver.

3. Click the close button to close the screen.

® cick

RMOD Select
[Remate OMN]

LA

MOD LEVEL

@ Select

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function.
To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the
[F1] key on your PC’s keyboard.

NOTE:
* DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not
work properly after the PC resumes normal activity.
* When not using the transceiver:
Follow the steps below to finish the remote control operation.
1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller
application.
2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
3. Turn OFF the transceiver and the PC.
@ If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also
turned OFF.
« When you manually select the transmit audio input connectors to be used after finishing the remote control
operation, right-click in the toolbar, or click “Remote Setting...” in the File menu to select.
® Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.
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Bl 5 ABOUT THE REMOTE UTILITY

Setting your PC’s environment

Configure your PC’s environment in the Remote Utility.

The settings will take effect after rebooting the Remote Utility.

® When you first open the Remote Utility, the Settings screen is displayed.
After configuring the settings, you can display other setting screens.

1. Click “Options.” B rcom Remote Uiy
2. Click “Settings.” o s 2en ] (D Click
» The “Settings” screen is displayed. m_ @ Click - \
3. Configure the settings. N 4
4. Click <OK> to save the settings.
* “The changes will be effect after the application 3 Set ? X
restarts.” is displayed. PC Hame Q=<
5. CI'Ck <OK>. Control Port (UDP) W
® The settings will take effect after restarting the serpor (0@ | [2002
Remote Ut”lty Audic Port (UDP) [so00d
Network Comnectio @) [wired -
Internet Access L\ne e 4]
s © [ngisn -
| @ Click
Remote Utility X
The changes will be effect after the applicati
® Click
©PC Name

Enter a name for your PC of up to 16 characters.
® DO NOT use the same name for more than one PC on your network.

@ Port numbers
Enter the port numbers of the Control, Serial, and Audio ports.
You should use the default port numbers for these ports.

© Network Connection
Select the network connection type.

O Internet Access Line
Select your internet access line type.

O Language
Select the software display language.
The selected language will be used as the Help file language.

NOTE: If you configure the remote control system through the Internet, and change the port number of the
Control, Serial or Audio port, you should reconfigure the port forwarding settings and the IP filter settings on your

router. (p. 4-4)
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5 ABOUT THE REMOTE UTILITY

Transceiver Registration

In the Remote Utility, register the transceivers that are physically connected to your PC.
See p. 2-2 to connect a transceiver to your PC.

< Adding a transceiver

i “ i ? B Icom Remote Utility H - X
1- CIICk “Opt|0ns. . » File Setup Wizard| Options @ CIICk
2. Cl!ck Local/Server Settings. ot e [ ] (@ Click
3. Click <Add>. T Settings.
» The “Purpose of use” screen is displayed. , Crmnsny

4. Select an option, and then click <Next >>.
@ If you select “Only accessible from this PC,” the

registered transceiver cannot be operated from v
other PCs. If you want to operate the Base station
transceiver from other PCs, select “Accessible from p—— T %
other PCs.” Regstered Rado Ut | ser Management
5. Set the transceiver information according to the o g

displayed screen. Public
® See pages 2-7, 3-4, or 4-7 about the settings.

add | | Deets | Propertes
|
Register a Rad) 7 X
Purpose of use
Select the purpose of use of the radio.
Select the purpose of use of the radia below. and then elick <Nexts.
 Only accessible from this PC.
& {iccesshbie from other FCs:
< Bac | Next > | Cancel

TIP: When you add a transceiver from the Setup Wizard screen, click “Setup for a Server PC (The radio is
accessible by Remote PC(s).)” or “Setup for a Local PC (Directly connect the radio and PC).”
® To display the Setup Wizard screen, click “Setup Wizard” on the top menu.
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Transceiver Registration

¢ Changing a transceiver’s properties Brentemetin— (D Click - x

File SEtulezardm‘ >
Click “Options.” radorst 5o [ ommmseine ] (2) Click
Click “Local/Server Settings.” Ic-7851 -
Select a transceiver. T ;
Click <Properties>. v

Change the settings, and then click <OK>.

oo =

Local/Server Settings ? X

Registered Radio List | User Management

1C-7300 %

Public

‘I\/\/\/\_/T

add | Delete | Properties | |
L
Radic Properties ? x
Connected Device Type - ¥ Public
Radio Name [1C-7300

¥ v address [s4 Baud Rate [115200

- COM Port/Audio Setting:

* Auo [1c-7300 COM=3 hd

 Manual

COM Port Number  [op3 ~

AF Input Device

[not used |
MOD Output Device

[Not used N T |

I? Displays Detected Auta Device

I Displays Virtusl Device:

Search
e

< Deleting a transceiver e = @ Click ) )

Click “Options.” Rotoin: sene [ masmersemnge ] (2) Click
Click “Local/Server Settings.” Ic-7851 =

Select a transceiver.
Click <Delete>.

Ll ol

Local/Server Settings ? x

Registered Radio List |USE, Management

IC-7300

Public

Add Delete | [oroperties |

@ Click
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Transceiver Registration

< Adding a user who can access the transceiver

1. Click “Options.”
2. Click “Local/Server Settings.”
3. Click the <User Management> tab.

B Icom Remote Utility @ - - X
File Setup Wizard| Options CIICk

o e [ msmwrssine ] (2) Click

Settings..
1C-7851

Local/Server Settings ? X
REg\stErEdRadle: @ C||Ck
1C-7300 A
Registered Users Accessible Users
1 USERT (Admin
Add>x
<<Delete
Add Properties
Delete
Adding a user
1. Click <Add>.
Local/Server Settings 7 x
2. Enter auser ID of up to 16 characters, case I
-tive Registered Radio List ser Managemen
sensitive.
® You cannot register an already registered ID. . ‘C'”": =l
Registered Users Accessible Users
3. Enter a password, of 8 ~ 16 characters, case TSERL Cadmm
sensitive. pido>
® At least 2 different characters must be used. <<odete

4. Click <OK>.

To prevent unauthorized access:

Set a long and strong password so that no one can
possibly guess it. Mix upper and lower case letters,
numbers or characters.

5-4

|Add User ? x

@ Enter |UserID fosez
® Enter -
(Example: ﬂl

USER0002) - @) Click | To set the user as
an administrator,

click to put a
check mark.
Local/Server Settings 7 X
Registered Radio List  User Management
1C-7300 -
Registered Users Accessible Users
USER1 (Admin’ USER1 (Admin’
Add>>
<<Delete

Add Properties
Delete
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Transceiver Registration

< Adding a user who can access the transceiver (Continued)

To allow a user to use a transceiver

1. Select a transceiver that you allow the user to use.

2_ Select the user. Local/Server Settings ? X
3- Cllck <Add>>>. Registered Radio List User Management @ Se|eCt

1c-7300 =

Registered Users Accessible Users

USERL (Admin

@ Click _ > | @ Click
<<Delete ’

|

Add Propertiss
Delete

v

Local/Server Settings ? X

Registered Radio List  User Management

1C-7300 hd

Registered Users Accssible Users
USERL (Admin Admin
d USERZ (Admin)

Add>>
<<Delete

Add Properties

Delete

Bl

To inhibit a user to use a transceiver
1. Select a transceiver that you inhibit the user to

use Local/Server Settings 7 x
) Registered Radio List  User Management
2. Select the user. @ Select
. x >
3. Click <<<Delete>. i 211 =
SR [u;;nz CAdmin) @ C|ICk

Add>>

<<Delete @ Cllck
|

il

Add Properties

Delete

Bl
i

4

Local/Server Settings ? X
Registered Radio List  User Management

1C-7300 ~

Registered Users Accessible Users
USERL CAdmin USERL (Admin

Add>3>
<<Delete

Add Properties

Delete

s
i
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Transceiver Registration

To change a user properties

1. Select a user.
2. Click <Properties>.

3. Change the settings, and then click <OK>.

To delete a user

Local/Server Settings 7

Registered Radio List  User Management

1C-7300 -

Registered Users Accessible Users

@ Click Add>>
’ <<Delete

w_|[ === @ Click
Delets

v

User Properties ? x

User ID luser2)]
e l—:“““: ] 2k

® Click

1. Select a user.
2. Click <Delete>.

5-6

Local/Server Settings 7

Registered Radio List User Management

1C-7300 -

Registered Users Accessible Users

@ Click e |
<<Delete

Properties |

ad |
@ Click
4

Local/Server Settings ?
Registered Radio List ~ User Management |

1C-7300 -

Registered Users Accessble Users
i 3 USERL (Admin,

Add>>
<<Delete

Add Propertiss

Delete
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Server Registration

To connect to a Base station transceiver through the network, Remote PCs should first connect to a Server using
the Remote Utility. Before connecting, enter the Server information.

< Adding a Server

1. Click <Server List>.
2. Click <Add>.
« Set the Server information according to the displayed
screen.
® When connecting to a Base station transceiver
through a LAN, see page 3-10 about the settings.
When connecting to a Base station transceiver
through the Internet, see page 4-11.

TIP: When you add a server from the Setup Wizard screen, click “Setup for a Remote PC (A radio with the Server
function)” or “Setup for a Remote PC (Connect through a Server PC).”
® To display the Setup Wizard screen, click “Setup Wizard” on the top menu.
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Server Registration

< Changing a server’s properties
1. Click <Server List>. B icom Remote Utity - x

Eile  Sern

2. Select a server. e @ Click
3. Click <Properties>.
4

Change the settings, and then click <OK>.

2 Select

add | Remove I| Properties | | @ C||Ck il

Server Properties ? x

Server Desaription

Network Settings

Server Address Control Port
or Network Name

|1:-7351 | 50001

User ID Password
=0 [==

I™ Disable the Server

e

< Deleting a server
1. Click <Server List>. B lcom Remts Uty - x

Setrim Wizard _ Onbinnr  Lnin

File
2. Select a server. wiu smem] (D Click

3. Click <Remove>.

192.168.68.10)

USER1

Intemet Access Line  FTTH

@ Select

add Remove || @ Click ﬂ Disconnect
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Connecting to a Server

< Connecting to a Server

Click <Server List>. B et ) )
Select a server. =]

Click <Connect>. IC-7851

“Connected” is displayed under the Server name : -

when the connection has succeeded. ‘

@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-1) @2 Select

pON =

< Disconnecting from a Server

1. Click the <Server List> tab. e e 1 ) )
2. Select the connected server. radots] i | (D Click 2]
3. Click <Disconnect>. Ic-7851

Connected

t (UDP)
USERT

Intemnet AccessLine  FTTH Round-rip  3msec Packet Loss 3%

@ Select

Add Remove Properties | Cormect Discornect | @ C|ICk
|
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Connection setting

When the connection to the Server has succeeded, the Base station transceivers are displayed on the Radio List

screen. Select a transceiver from the list, then connect it to the network using the Remote Utility.
You have to configure the network audio quality and devices to connect.
® To control the transceiver, connect to the transceiver using the Control software.

List screen and then clicking <Connect>.

TIP: If the connection setting is finished, you can simply connect to the transceiver by selecting it on the Radio

Click <Radio List>.

Select a transceiver.

Click <Settings>.

® Fot the transceivers that are “<<Connected>>" or

whh =

“Offline,” the Connection Setting cannot be changed.

NOTE: When using the DUAL mode screen in the
Remote Controller, set the codec setting for
“AF Transmission” to 2 channels.

5-10

B 1com Remote Utility

File Setun Wisard  Onbinne  Heln

@ Click

IC-7851abe

00

@ Select

Settings || @ Cllckl & | MOD | Wonitor | Delete

v

IC-7851abe (IC-7851) ? X
- Network Setting
[V AF Transmission [¥ MOD Transmission
SampleRates  [16kz =] [aetz =l
Codecs [Lpem 2ch 16bit =] [ecm 1ch 16bit =]
Prebuffer (ms) O 80 —1 100
[¥ Retransmission Audio Data Recommended
~Device Setting:
Virtual COMPort Number [EE T - |
Specker [Default Device =] [ ]
Mic [Default Device x| [z ]
Virtual Audio Sample Rates (change effectve after the application restarts.) |48z~
oK I Cancel |
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Connecting to a transceiver

If the connection setting is finished, you can simply connect to the transceiver by selecting it on the Radio List
screen and then clicking <Connect>.

< Connecting to a transceiver

2. Select a transceiver.
3. Click <Connect>.
4. Click <OK>,
« “<<Connected>>" is displayed under the radio name
when the connection has succeeded.
® If the connection fails, and an error screen is @ select
displayed, solve the problem. (p. 7-2)

EJ Icom Remote Utility - *
. < . . > File  Setin Wirard Ommn:I Healn
1. Click <Radio List>. @ Clic

IC-7851abc

Settings Connact| @ Cl|ck J MOD: | Manitar | Delete

Remoate Utility X

Virtual serial port numberis (2).

@ Click
< Disconnecting a transceiver
1. Click <Radio List>. e e -
2. Select a transceiver with “<<Connected>>" under @ Click
its name. IC-785Tabo 5
3. Click <Disconnect>. < Cannactad >>

« “Do you want to disconnect the radio?” is displayed.
4. Click <Yes> to disconnect the transceiver.

NOTE:

* Be sure to disconnect when not using the
transceiver. Otherwise, other users cannot connect
to it.

* The administrators can terminate a connection
between another user and a transceiver. If )
“<<Connected>>" disappears while connecting to =ew |0 [ ]| @ Click Jee | |

a transceiver, the administrator may terminate the

connection. '

Remote Utility

Do you want o disconnect the radio?

(=] @ click
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ABOUT THE REMOTE UTILITY

Adjusting audio level using the Remote Utility application

While connected to a Base station transceiver, you can adjust the received and transmit audio volume through the
network using the Remote PC’s Remote Utility.
The description in this section is based on the assumption that the connection to the transceiver has succeeded.

(“<<Connected>>" is displayed under the radio name.)

< Adjusting received audio volume

1. Click <Radio List>.

2. Select a transceiver with “<<Connected>>" under
its name.

3. Click <AF>.

4. Slide the adjustment bar on the Volume field up or

down to adjust the received audio volume level.
® Click <Mute> to mute the audio, and click once again
to hear the audio.
5. Click <Close> to close the screen.

NOTE:

e The AF adjustment bar on the Volume field
moves together with the AF control of the Remote
Controller. However, if you use another control
software, the audio volume level on the network
can only be adjusted with the Remote Utility.

* You cannot adjust the received audio volume level
of the transceiver’s speaker, with the Remote
Utility. Use the AF control on the transceiver to
adjust it.

* When setting the codec setting for “AF
Transmission” to 1 channel, the volume level of
both right and left are the same.

B Icom Remate Utility - X

File_ Setun Wisard  Ontinnc

- @ Click

<< Connected 2> 1

@ Select

Settings | Connect | D\snnedl AF | @ Cllck Delete

IC-7851abe (IC-7851) ? X
u g
[ I sample Rates 16kHz =
Codecs LPCM 1ch 16bit -
T T ¢ mn Open Folder
i 00:00:00
0dB 0dB
L AF R
= Mute Rec Folder
™ LRMix IC:‘usErs\ «\Documents \lcom \RemoteUtyrec
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< Adjusting transmit audio volume

1. Click <Radio List>.

2. Select a transceiver with “<<Connected>>" under
its name.

3. Click <MOD>.

4. Select “Mic” in “MOD Select.”

5. Slide the adjustment bar on the Volume field up or
down to adjust the transmit audio volume level.
6. Click <Close> to close the screen.

NOTE: You cannot adjust the modulation input
level of the transceiver with the Remote Utility.
Adjust the modulation input level of the transceiver
in the transceiver’s Set mode, or using the Remote
Controller. (p. 6-2)

EJ Icom Remote Utility - ®
File  Setun Wirard  Ontinne

1% Ciioi

IC-7851abc

<< Connected >>

2 Select

Settings | Corneet | D\smnne:tl

« [ 1] ® Click |
v

IC-7851abce (IC-7851) ? x

[7MOD Select

Volume ——

[ me

Default Device

® Adjust

| Cvay
i Fie

0ds

Mic " Not use

@ Select

P|-|Ii|

00:00:00

d

=~ | ® Click
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ABOUT THE REMOTE UTILITY

Recording and playback function

While connected to a transceiver, you can record the received audio and save it into the PC’s hard disk using the

Remote PC’s Remote Utility.

Also, you can transmit an audio file to the radio using the Remote Utility.
The description in this section is based on the assumption that the connection to the transceiver has succeeded.

(“<<Connected>>" is displayed under the radio name.)

< Recording received audio

1. Click <Radio List>.

2. Select a transceiver with “<<Connected>>" under
its name.

3. Click <AF>.

4. Click < ®|> to start recording.
® While recording, click < 11l > to pause.

5. Click < ®/> to stop recording.

TIP:

* When you click <Open Folder>, the folder in which
the recording file is saved is displayed.

« If you want to change the recording folder, click
< - />, then select a folder on the Browse For
Folder screen.

« Adjust the sample rate frequency and codec
to record the audio according to the recording
purpose. When you record the audio received
from the network, we recommend that you set the
same sample rate frequency and codec that are
programmed on the Connection Setting screen.
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B 1com Remote Utility

File  Sehun Wizard  Ontinne  Heln

Radio List | ¢ @ C||C
IC-7851abe [ 92
<< Connected >> E E
0 \UDI0-1 [1=0 0=0] ; M\_][l
@ Select
Settings | Connect. I Disconne ctl AF | @ Cllck Delet:

v

Record button
Stop button
Pause button

1C-7851abc (IC-7851)

7

x

Close

L
|

Recording folder name

[ ‘ Sar[ole Rates lm
1 | o [Formm: o
[o m|m Open Folder Open the folder
’ 20180619_131356.wav Recording file name
= - || Elapsed time
L AF R
Mute Mute Rec Folder
I LR Mix Ic:usersu \Documents{icom\Remotelityrec

Folder browse button
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Recording and playback function

< Playing back and transmitting an audio file

1. Click <Radio List>. T e - )
2. Select a transceiver with “<<Connected>>" under @ Clic
its name. IC-7851abc

3. Click <MOD>. << Connected >>
4. Select “File” in “MOD Select.”
5. Click <Open> to select an audio file* to play or
transmit.
* Only uncompressed, linear, PCM WAV files are
supported.
6. Click < » > to start playing/transmitting.
® While playing or transmitting, click < 11! > to pause.
7. Click < m > to stop playing/transmitting.

Settings | Corneet | Dismnne:tl AF MOD | @ C||Ck d

TIP: You can also use the Remote Controller’s Voice A 4
Memory function to play back or transmit an audio
file. See the Remote Controller’s help file for details. Playback button
To display the help file, click “Contents” in the Help —— Stop button
menu on the Remote Controller, or push the [F1] key —— Pause button
on your PC’s keyboard- \C-7851abc (IC-7851) ? X
rVolume —— ~MOD Select
 Mic [|=fault|3evic|:
¥ Audio 1):om_[aupifs-2
 Fie > m| 1| open ol Open the folder
C:\Usersipe\Documents comRemot=Uty &——— Audio file name
00:00:00 Elapsed time
0dB
File " Notused

Close
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Monitoring another users from the Server PC

When you are operating a Server PC, and another user is accessing a Base station transceiver that is physically
connected to your PC, you can monitor the received and transmitted audio.
® To monitor, you should connect a speaker to your PC.

1. In the Server PC’s Remote Ultility, click the <Radio Bionfenacuiy - *
List> tab. @ Click Ea)
2. Select a transceiver with “Busy” under its name. 1C.7300 0

® The operating user’s name (PC Name that the
Remote PC set in the Network Setting screen), and
its IP address are displayed under “Busy.”

Click <Monitor> to display the Monitor screen.

Click <TX Monitor> to turn the Transmit Monitor

function ON or OFF.

Click <RX Monitor> to turn the Receive Monitor

function ON or OFF.

Slide the adjustment bar on the Volume field up or

down to adjust the monitoring audio volume level.

5. Click <Close> to close the screen.

0-4]

@ Select

B w

Settings | Commect | Discormect | aF | MoD Monitor | @ C“Ck
|

X

TX Monitor )
RX Monitor 0 CIICk

@ Adjust

© Click

. @@
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Disconnecting another users

The administrators and the Server PC can terminate a connection between another user and a transceiver.

1. Click <Radio List>. Blentenacuyy - *
2. Select a transceiver with “Busy” under its name. @ Click
® The operating user’s name (PC Name that the user 1C.7851abo e

set in the Settings screen), and its IP address are
displayed under “Busy.”
3. Click <Disconnect>.
« “The radio is in use by a remote PC. Do you want to
disconnect?” is displayed. @ select
4. Click <Yes> to terminate the connection.
® When you terminate a connection, no dialog is
displayed on the disconnected user’s Remote Utility.

Busy

UDI0-1 [1=0 0=0]

Settngs | comect | [Discormect @ Cl|ckJ Maritor Delete

Remote Utlity

The radio is in use by a remote PC. Do you want to disconnect?

_ @ Click
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Connect to the Base station transceiver.
(p. 2-11, p. 3-14, p. 4-15)

About the Remote mode Open the Connect Setting screen.
(p. 6-2) (p. 2-11, p. 3-14, p. 4-15)

- R|-BA1 Remc|e Control

FILTER
FILTER FILTER

— TWIN-PBT — SUB

TRANSMIT

P.AMP 1
§ TUNER AGC-FAST

<! o o
TUNE R-15k R-15k

—~a PPUSBE™ (FIL2) (75-100 PUSE™ (FiL2 [ T5-100
) E28 CRUSEAN) (FL2/( T5-100 (TN Fi.2 | T5-100 T PR T PETR

W : 14.100.00 ’...!\-'IAIr-J.-.—I‘JDTIZI-I— S

I BKIN : 1E_E”“L

[]
1 PAMP - . : i
I APF

I TPF
TEW WIDE

MODE
PSK AM GENE § TONE

¥ DIGISEL

B DUAL-W 1 SPLIT i SUB

MEMORY
MP-W MP-R

MEMO GROUP
v A
DOWN  UP

M-CLR

To use transmit audio input from the PC (p. 6-2)

TIP: See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function. To display the Help file, click “Contents” in the Help menu on the
Remote Controller application, or push the [F1] key on your PC’s keyboard.

The windows that are displayed by right-clicking on each button on the Remote Controller, see the Operating
Guide at the end of this manual.
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To use transmit audio input

from the PC

In order to use the transmit audio input from the PC
function when remotely controlling the transceiver
using the Remote Controller, configure the following
settings, according to the connection between the
transceiver and the Server PC.

If you operate from the Remote PC, confirm the
transceiver is connected to the Server PC.

1. Connect to a transceiver with the Remote
Controller.

2. Click <MIC SET> to open the MIC SET screen.

3. Select an appropriate connector in MOD Select
(Remote ON), to input transmit audio from the PC
to the transceiver.
® The options differ, depending on the transceiver

selected in Model on the Connect Setting screen.

4. Right-click <MOD LEVEL> to rotate clockwise, or
left-click it to rotate counterclockwise, to adjust the
input level from the connector.

5. Click < £ > to close the screen.

® cick
MOD Select
[Rermate OMN] ® Select
-
MOD LEVEL
O @ Adjust
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About the Remote mode

When connected to the transceiver, the Remote
Controller automatically turns ON the Remote mode.
While the Remote mode is ON, the Remote Controller
transmits CIl-V commands not only to check the
transceiver’s current state, but also to remotely control
it.

When you want the Remote Controller to only check
the transceiver’s current state, or when you want

to inhibit the Remote Controller from transmitting
control commands while you manually operate the
transceiver, turn OFF the Remote mode.

To turn OFF the Remote mode
Click the Remote icon in the toolbar, or click
“Remote OFF” in the File menu.

To turn ON the Remote mode
Click the Remote icon in the toolbar, or click
“Remote ON” in the File menu.

® You can select the desired connector(s) for
transmitting audio input when the Remote mode
is OFF. See the Remote Controller’s Help file for
“Remote Setting” details.

NOTE: DO NOT allow the PC to go into the sleep or
standby mode while using the RS-BA1. Otherwise, it
might not work properly after the PC resumes normal
activity.
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Using the RC-28

If you connect the optional RC-28 REMOTE ENCODER
to your PC, you can use the RS-BA1 and feel like you
are operating the actual transceiver’s MAIN dial.

1. Connect the RC-28 to the PC that has RS-BAl
installed.
® When you connect the RC-28 to the PC for the
first time, wait until “Device driver software installed
successfully.” is displayed.

NOTE: DO NOT connect the RC-28 to the PC with
other than the supplied USB cable, or through any
USB hub. The RC-28 may not work properly.

:i}'f’?j =2\
T

A‘%M

to a [USB] port USB cable (supplied)

—— [LINK] indicator

» The [LINK] indicator on the RC-28 lights green.
« Now you can control the assigned functions of the RS-
BAL1 using the RC-28.

TIP: If the [LINK] indicator does not light, check the

following.

1. Click “USB Dial...” in the Option menu to open
the USB Dial Setting screen.

2. If Select Device is set to “Not Use,” set it to the
RC-28's serial number.
(Example: RC-28 02XXXXX)
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The following are possible causes and solutions for the problem you are experiencing.
If you cannot solve the problem after trying these solutions, please contact your nearest dealer or lcom Service
Center.

Problem: Cannot access a Server from a Remote PC with the Remote Utility
® You can configure the Server information on the Server Properties screen. (Server List screen = <Properties>)

“Connection Failed” is displayed under the Server name

IC-7851 Possible cause 1

An incorrect IP address, domain name, or network name (Computer name) is entered
Connection to request a connection to the Server.
Failed @ If the Remote Utility cannot get the Server’s IP address using the domain name or

network name (Computer name) that you entered, “Cannot resolve the name” is
displayed next to the name.

Solution

1. Check the Server’s IP address, domain name, or network name (Computer
name). (pp. 3-2, 4-2)

2. Enter the Server’s correct IP address, domain name, or network name in Server
Address or Network Name on the Server Properties screen.

Possible cause 2
The control port number is different than that of the Server.

Solution

1. Check the Server’s control port number®. (pp. 2-2, 4-4)

2. Enter the correct port number into Control Port (UDP) on the Sever Properties
screen.
* The default number is “60001.”

Possible cause 3
The virtual driver is not installed in the Remote PC.

Solution
Install the virtual driver in the Remote PC.
(See the RS-BA1 PREPARATION for details.)

“Logon Failed” is displayed under the Server name

IC-7851 Possible cause
The user ID or password is different than the one in the Base station.
'EDFJID; Solution
== 1. Confirm the Remote PC information registered in the Base station.
(pp. 3-2, 4-5)

2. Enter the correct user ID and password into User ID and Password on the Sever
Properties screen.

“Disabled” is displayed under the Server name

IC-7851 Possible cause
The Server is set to “Disable,” to inhibit connecting to it.

Enable the Server by removing a check mark from Disable on the Sever Properties
screen.
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NOTE: If you could not solve the problem after trying the solutions, check the following on the Base
station.

When connecting to the network directly:
« Is the transceiver turned ON or Remote standby mode?
* Is Network Control set to “ON"? (pp. 3-2, 4-5)

When connecting to the network through a PC:

« Is the Remote Utility activated?

* Is your Remote station information registered on the Remote Utility’s User List screen? (p. 5-4)
« Is the Remote Utility added as an exception in the Firewall? (p. 1-1)

Problem: Cannot access a transceiver with the Remote Utility

The description in this part is based on the assumption that the connection to the Server has succeeded.
* “Connected” is displayed under the Server name when the connection is successful.

Possible cause
Another user is currently operating the transceiver.

Solution

Wait for “Busy” to disappear.

® If you are operating as an administrator or a Server, you can terminate a
connection between another user and a transceiver. (p. 5-16)

is displayed under the radio name

Possible cause 1
The serial port number (default: 50002) or the audio port number (default: 50003) is
not connected.

Solution
Check the Firewall settings for the Remote PC.
When using the Internet, also check the router’s port forwarding settings. (p. 4-4)

Possible cause 2
Access to the selected transceiver is inhibited by the Server PC.

Solution
Allow the Remote PC to access the transceiver with the Server PC’s Remote Utility.
(p. 5-4)
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“COM/Audio Error” is displayed under the radio name

IC-7851abc Possible cause 1
Other applications are using the COM port.

Idio

Solution
If other applications are running at the same time, close them.

Possible cause 2
Started the Remote Utility right after the PC has booted.

Solution
Wait for a while after the PC has booted, and then start the Remote Utility.

Possible cause 3
An audio device or COM port has been added to the PC, or removed from the PC.
For the USB device, the USB port number has been changed.

Solution
The COM port number or the audio device name may have been changed.
Reregister the radio on the Registered Radio List screen. (p. 5-2)

Possible cause 4
The audio or serial wiring is disconnected.

Solution

If you are using a USB serial conversion cable or a USB audio cable, make sure the
USB cabile is firmly connected.

Make sure the 3.5 (d) mm (1/8”) audio cable is firmly connected.

NOTE: If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
« Is the transceiver turned ON or in the Remote standby mode?

When connecting to the network through a PC:

« Is the transceiver turned ON?

« Are the correct COM port number and audio device to which the transceiver is connected selected on
the Radio Properties screen?
(Option = Local/Server Settings = Registered Radio List screen = <Properties>)

« Is the Server PC not directly accessing the transceiver using the Remote Controller, without having
used the Remote Utility to connect to the transceiver?
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Problem: Cannot access a transceiver with the Remote Controller

® To access a transceiver with the Remote Controller, configure the connection settings on the Connect Setting
screen. Click < E > in the toolbar, or click “Connect Setting...” in the Option menu to open the screen.

The description in this part is based on the assumption that the connection to the transceiver using the Remote

Utility has succeeded.

 “<<Connected>>" is displayed under the radio name when the connection is successful.
When connecting to the transceiver through the network using the Remote Utility

Possible cause 1

In CI-V of the Remote Controller’s Connect Setting screen, the CI-V settings are different than that in the
Remote Utility.

Solution

On the Connect Setting screen, click <Search>, and then select the correct transceiver in the Remote
Utility menu.

» The CI-V settings are automatically loaded from the Remote Ultility.

Possible cause 2
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.

NOTE: If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
* Is the transceiver turned ON or in the Remote standby mode?

When connecting to the network through a PC:

« Are the same CI-V address and baud rate that are programmed into the transceiver set on the Radio
Properties screen?

(Option = Local/Server Settings = Registered Radio List screen = <Properties>)

When directly accessing the transceiver without using the Remote Utility

Possible cause 1
An incorrect COM port number is set on the Remote Controller’s Connect Setting screen.

Solution
1. Check the COM port to which the transceiver is connected, on your PC’s Device Manager.
2. Set the correct COM port number to COM Port on the Remote Controller’s Connect Setting screen.

Possible cause 2
The CI-V address or baud rate is different than that are set into the transceiver.

Solution
1. Check the transceiver’s ClI-V address and baud rate.
® See the transceiver’s instruction manual for details.
2. Enter the transceiver’s correct Cl-V address in CI-V address (Radio), and select the transceiver’s
correct baud rate in Baud rate (bps), on the Remote Controller's Connect Setting screen.
@ If the radio’s baud rate is set to “Auto,” select “19200” in the Baud rate (bps) menu.
@ If you are using the Spectrum Scope function with the IC-7851, IC-7850, IC-7610, or IC-7300 using a USB
for the connection, select “115200” in the Baud Rate menu.

Possible cause 3
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.
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Problem: The DUAL mode screen of the Remote Controller cannot be displayed

® To access a transceiver with the Remote Controller, configure the connection settings on the Connect Setting
screen. Click < ﬁ > in the toolbar, or click “Connect Setting...” in the Option menu to open the screen.

Possible cause
An incorrect transceiver’'s model is set on the Remote Controller’'s Connect Setting screen.

Solution
Select a model named with “(DUAL).”

Problem: Cannot properly control the transceiver with the Remaote Controller

Possible cause
The same CI-V address is being used by other control software.

Solution
Select an address other than “EQ” in CI-V Address (RS-BA1) on the Remote Controller’s Connect
Setting screen. However, this solution does not always solve the problem.

NOTE:
If you could not solve the problem after trying the solutions, check the following.
« Are there any radios that have the same CI-V address in the system?
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Problem: The received audio cannot be heard.

The description in this part is based on the assumption that the connection to the transceiver has succeeded.
 “<<Connected>>" is displayed under the radio name when the connection is successful.

Possible cause 1
The speaker is not turned ON, or the volume level is too low.

Solution
Turn ON the speaker, or adjust the volume level.

Possible cause 2
An earphone or other device is connected to the computer in place of the speaker.

Solution
Disconnect the device.

Possible cause 3
The appropriate audio device is not selected in the Remote Utility.

Solution

Select the appropriate audio device in Speaker on the Connection Setting screen.

(Radio List screen = <Settings>) (pp. 3-12, 4-13)

@ If you connect a new USB audio device to your PC, the audio device which is selected as a default
device in your PC can be changed. If you select “Default Device” in Speaker, keep that in mind.

Possible cause 4
The volume level of the audio device is set to too low on your PC.

Solution

Adjust the volume level of the audio device. (p. 1-4)

® The PC has the Volume Mixer function that can adjust each application’s audio level. Confirm that the
Remote Utility or the control software is not muted, or set it to an appropriate volume level.

Possible cause 5
Audio output is disabled in the Remote Utility.

Solution
Insert a check mark in AF Transmission on the Connection Setting screen.
(Radio List screen = <Settings>)

Possible cause 6
The volume level is too low, or the mute is turned ON in the Remote Utility.

Solution
Adjust the volume level on the Received Audio Adjustment screen.
(Radio List screen = <AF>) (p. 5-12)

NOTE:
If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
« Is Network AF set to an appropriate level in the Others set mode?

When connecting to the network through a PC:

« Is the volume level of the audio device that the transceiver is connected to set to an appropriate
level?
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Problem: The received audio cannot be heard in the DUAL mode.

® See also “Problem: The received audio cannot be heard.”

Possible cause 1
The codec setting for the received audio is set to 1 channel on the Remote Utility’s Settings screen.

Solution
Set the codec setting for the received audio to 2 channels.

Possible cause 2
When the transceiver is connected to the PC with a USB cable, the audio device setting is incorrect.

Solution
Set the microphone’s Default Format to 2 channels on the Windows Sound setting screen.

7-7



{ TROUBLESHOOTING

Problem: The transmit audio cannot be output.

The description in this part is based on the assumption that the connection to the transceiver has succeeded.

 “<<Connected>>" is displayed under the radio name when the connection is successful.

® To check the Remote PC’s transmit IF signals, use the Transmit Monitor function with the Server PC’s Remote
Utility, or place a receiver near the Remote PC or Server PC.

Possible cause 1
The microphone is not turned ON, or the input level is too low.

Solution
Turn ON the microphone, or adjust the input level.

Possible cause 2
The appropriate audio device is not selected in the Remote Ultility.

Solution

Select the appropriate audio device in Mic on the Connection Setting screen.

(Radio List screen = <Settings>) (p. 5-10)

@ If you connect a new USB audio device to your PC, the audio device which is selected as a default
device in your PC can be changed. If you select “Default Device” in Mic, keep that in mind.

Possible cause 3
The input level of the audio device is set to too low on your PC.

Solution
Adjust the input level of the audio device. (p. 1-4)

Possible cause 4
Audio input is disabled in the Remote Utility.

Solution
Insert a check mark in MOD Transmission on the Connection Setting screen.
(Radio List screen = <Settings>)

Possible cause 5
The input level is too low in the Remote Utility.

Solution
Adjust the input level on the Transmit Audio Adjustment screen.
(Radio List screen = <MOD>) (p. 5-12)

Possible cause 6
An incorrect connector is selected in the Remote Controller.

Solution
Select the proper transceiver’s connector which is connected to the Server PC, in MOD Select (Remote
ON) on the Remote Controller’s MIC SET screen. (p. 6-2)

NOTE:
If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
« Is Network AF set to an appropriate level in the Others set mode?

When connecting to the network through a PC:

« Is the volume level of the audio device that the transceiver is connected to set to an appropriate
level?
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Problem: The received audio is intermittent

Possible cause 1
The network data transfer is excessive.

Solution

Select a lower sampling rate value in Sample Rates, or a different codec in Codecs, on the Connect

Settings screen. (Radio List screen = <Settings>)

® First, select the lowest value. If the received audio is not interrupted with the setting, try a higher
value, and adjust to an appropriate value.

Possible cause 2
The capacity of the prebuffer is not enough.

Solution

Select a longer value in Prebuffer (ms) on the Connection Setting screen.

(Radio List screen = <Settings>)

® Select as short a value as possible, because longer prebuffers can cause a delay, and make it difficult
to adjust the audio level.

Possible cause 3
Your PC is overloaded.

Solution 1
Shutdown other applications, if running.

Solution 2
Reduce the number of transceivers you are accessing with the Remote Utility.

NOTE:

« If you are accessing the transceiver through a network, removing a check mark from Retransmission
on the Connection Setting screen can solve the problem.
(Radio List screen = <Settings>)

* You can check the simplified packet round trip time, and the average packet loss on the Remote
Utility’s Server List screen.

IC-7851

Connected

Packet round trip time Average packet loss

Problem: The connect settings cannot be changed

IC-7851abc Possible cause 1

The transceiver is “Offline.”

Offline

— Solution

Click <Connect> on the Server List screen to connect to the server.

IC-7851abc Possible cause 2

“<<Connected>>" is displayed.
<< Connected >> .
Solution

Click <Disconnect> on the Radio List screen to disconnect from the transceiver.
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Problem: The connect settings cannot be changed using the Remote Controller

Possible cause
The Remote Controller is connected to the transceiver.

Solution
Click < @) > to disconnect it from the transceiver.
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Remote Controller Operating Guide (DUAL mode screen)

The following windows are displayed by right-clicking on each button on the Remote Controller.
® There are some windows that are displayed by left-clicking. The buttons are marked in white.

(Example: Memory Channel Editor).

® The windows whose title are with “(MAIN)” are displayed when you select the MAIN band.

When you select the SUB band, “(SUB)” is displayed instead.

® The windows that are displayed by right-clicking can also be displayed by right-clicking on the screen icons.

TIP:

(Set Mode > Controllers > Control Type)

* You can select either “Knob” or “Slider” on the Set Mode screen to adjust each setting.

» Some windows are not displayed, depending on the connected transceiver.
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Remote Controller Operating Guide (Single mode screen) TIP:

. . . . . * You can select either “Knob” or “Slider” on the Set Mode screen to adjust each settings.
The following windows are displayed by right-clicking on each button on the Remote Controller. (Set Mode > Controllers > Control Type)

® There are some windows that are displayed by left-clicking. The buttons are marked in white. . Some windows are not displayed, depending on the connected transceiver.

(Example: Memory Channel Editor).
® The windows that are displayed by right-clicking can also be displayed by right-clicking on the screen icons.
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